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Micro Focus Enterprise Developer 2.2
Update 2 for Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Micro Focus offers Enterprise Developer with the following licensing options that unlock different
functionality:

Micro Focus
Enterprise
Developer
Connect

Enterprise Developer Connect is for customers looking to use modern and productive
Eclipse-based tooling to develop mainframe applications directly on the mainframe.
Close integration to mainframe configuration management systems and the ability to
easily customize the Eclipse-based IDE to include mainframe-based tools and
processes means developers can take full advantage of modern development tools
without having to learn new development processes.

Micro Focus
Enterprise
Developer

Enterprise Developer is for customers looking to develop and modernize mainframe
applications in a productive and modern Windows-based development environment,
targeted for deployment onto an alternate server platform. Developers have the choice
of either the Visual Studio or the Eclipse-based IDE and development and test tools
are provided for all target environments currently supported by Micro Focus.

Micro Focus
Enterprise
Developer for
IBM zEnterprise

Enterprise Developer for IBM zEnterprise gives customers the choice to develop
directly on the mainframe or under Windows. Mainframe applications can be
developed, maintained and modernized regardless of where they will be deployed,
either back onto the mainframe or onto an alternative server environment. Support is
provided for both the Visual Studio and Eclipse-based IDEs and for all the
development and test tools for every target environment currently supported by Micro
Focus - including z/Linux, AIX and x86 environments. Enterprise Developer for IBM
zEnterprise combines all the capabilities of Enterprise Developer Connect and
Enterprise Developer.

Full mainframe integration and the Application Workflow Manager are only available in
the Eclipse-based IDE.

In addition, this document contains information on workflow modelling extensions in the section Enterprise
Developer for IBM zEnterprise Workflow Modelling Extensions .

Note: The Enterprise Developer Personal Edition option is not available with this release. You can use
the Personal Edition with Enterprise Developer 2.1 Update 1 - you can register for it on the Enterprise
Developer Personal Edition section on the Micro Focus Web site.

Note:

• The Application Workflow Manager is available within all Enterprise Developer variants and
provides all the capabilities and tools to develop and maintain Application Workflow models. These
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models allow you to integrate tools and processes directly into Enterprise Developer. You can use
the Application Workflow Manager with the following products:

• Enterprise Developer - the Enterprise Developer setup file automatically installs the Application
Workflow Manager.

• IBM Rational Developer for System z (RDz) - see Installing Application Workflow Manager into
Rational Developer for System z (RDz) in the installation instructions. This requires that
Enterprise Developer Connect is installed and licensed.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Enterprise Developer. For more information, read the section
Upgrading to Enterprise Developer for Eclipse in the product Help.

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

Installing Enterprise Developer

System Requirements

Hardware Requirements
z/Server has the following hardware requirements:

• IBM mainframe model z9-109 or later is required for installing and using z/Server. z/Server will not
install on earlier hardware models.

Enterprise Developer has the following requirements in addition to the requirements of Eclipse. See the
Eclipse documentation for details of its requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, it is recommended to have a minimum
of 2GB of RAM.

Windows

The disk space requirements for Windows are, approximately:

Platform Enterprise Developer Sentinel RMS License Manager

x86 Windows platforms 1.3GB 25MB

x64 Windows platforms 1.4GB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

UNIX

The disk space requirements for Micro Focus Enterprise Developer UNIX Components are approximately:
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Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER running
AIX

414 1.66 828 33

HP IA 789 3.16 1580 61

System Z running
Red Hat Linux

354 1.4 708 34

x86-64 running
Red Hat Linux

372 1.48 744 40

SPARC running
Solaris

442 1.77 884 38

System Z running
SuSE SLES

359 1.44 718 34

x86-64 running
SuSE SLES

377 1.51 754 40

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

Software requirements

Windows

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

If no Java is installed on your machine, the setup file installs Java 1.6u27.

If you are installing Enterprise Developer on a machine that has Java 7 or Java 8 installed, see the Java
Support in the Known Issues and Restrictions section in your product help for considerations that apply to
using the Eclipse IDE.

UNIX/Linux

These are the software requirements for Micro Focus Enterprise Developer UNIX Components:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x, you must have the following operating system libraries installed:

All Enterprise Developer products
glibc-*.x86_64
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glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries required to use
the core_on_error runtime variable

gdb - the gdb packages (for the GNU Project Debugger) can
be installed from the install media for your OS.

Additional libraries for Micro Focus
Enterprise Developer UNIX
Components

glibc-devel-*.x86_64
glibc-devel-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

Additional libraries for Micro Focus Enterprise Developer UNIX
Components

glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The earliest supported
release of Java 6 is 1.6 Update 27. You can download Oracle's Java EE from Oracle's Web site and
install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
1.6 is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Enterprise
Developer client and a new licensing server on the same machine.

Micro Focus Enterprise Developer 2.2 Update 2 for Eclipse Release Notes | 7

http://www.microfocus.com/docs/links.asp?nx=redhat
http://www.microfocus.com/docs/links.asp?nx=java
http://www.ibm.com
http://www.hp.com


If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

• Application server support for JVM COBOL on page 8
• Application server support for interaction with Enterprise Server on page 8
• AppMaster Builder Distributed Generation Server on page 9
• Java Development Kit (JDK) on page 9
• Consolidated Trace Facility on page 9
• Database Access on page 9
• Database Access - COBSQL (Pro*COBOL) on page 10
• Database Access - OpenESQL on page 10
• Database Access - HCO for SQL Server (HCOSS) on page 11
• Database Access - HCO for DB2 LUW on page 11
• Database Access - SQL Option for DB2 on page 12
• Micro Focus Rumba on page 12

Application server support for JVM COBOL

Back to Top

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 6.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

You need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6 is 1.6.027. You can download
Oracle's JDK from Oracle's Web site

Application server support for interaction with Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following J2EE application servers are supported using the following JDKs:
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J2EE Application Servers JDK (vendor) Java EE

JBoss 5 1.5/1.6 (Oracle) 5

JBoss 6 1.6 (Oracle) 6

Oracle WebLogic 10 1.5 (Oracle) 5

Oracle WebLogic 12 1.6/1.7 (Oracle) 6

IBM WebSphere 7.0 1.5 (IBM) 5

IBM WebSphere 8.0 1.6 (IBM) 6

IBM WebSphere 8.5 1.6/1.7 (IBM) 6

AppMaster Builder Distributed Generation Server

Back to Top

Restriction: This feature applies only when the AppMaster Builder AddPack has been installed, and
applies only to Windows platforms.

IBM WebSphere MQ version 7 and later.

Java Development Kit (JDK)

Back to Top

Native COBOL and
Java Interoperability

Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to run
the Eclipse IDE, to execute COBOL JVM code and for native COBOL and Java
interoperability. The earliest supported release of Java 6 is 1.6 Update 27. You
can download Oracle's Java EE from Oracle's Web site and install it anywhere on
your machine.

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interface Mapping
Toolkit (IMTK)

Restriction: This feature applies only when the Enterprise Server feature
is enabled.

The JDK is required for generating Java interfaces from the Interface Mapping
Toolkit or the imtkmake command.

Java Beans Your Java client needs to be compiled with JDK 1.6 or greater.

EJBs Use the same JDK vendor and version that is used by the
application server.

After installing the JDK, you need to set up your Java environment.

Back to Top

Consolidated Trace Facility

• The Microsoft .NET Framework 2.0 or later is required for the CTF Viewer. It is available from the
Microsoft .NET downloads area.

Database Access

Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, HCO for SQL Server (HCOSS), or OpenESQL, ensure any third-party software prerequisites
are installed and the environment is set properly.

Micro Focus Enterprise Developer 2.2 Update 2 for Eclipse Release Notes | 9

http://www.microfocus.com/docs/links.asp?nx=java


Database Access - COBSQL (Pro*COBOL)

Back to Top

Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running
Windows

X X

XA Switch Module The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. Certification
information can be found within the relevant Oracle documentation. If you have an
Oracle MetaLink account (http://metalink.oracle.com), document # 43208.1
provides details of all language compilers certified by Oracle for use with their
precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle,
do not use the COBSQL directive option NOMAKESYN, since this directive results
in COMP host variables, and on Intel platforms these are incompatible with the
native byte order expected by Oracle.

Back to Top

Database Access - OpenESQL

Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Windows

X X X

XA Switch Module The ODBC One-phase Commit switch module is provided and is available on the
same platforms as are indicated in the Availability section above. The SQL Server
XA switch module is also provided.

To build the SQL Server XA module, you must have the Windows Software
Development Kit (SDK) installed for your version of Windows.

Native COBOL
and PL/I

• OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

JVM Managed
COBOL

OpenESQL supports access to relational databases using JDBC 4.0-compliant
JDBC drivers. In order to utilize JDBC DataSource Objects, you must also install and
configure a JNDI server.
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Database Access - HCO for SQL Server (HCOSS)

Back to Top

Microsoft SQL
Server

SQL Server 2008 R2 or SQL Server 2012, Developer or Enterprise Editions, including
Microsoft SQL Server Management Studio.

Database
Migration

• Microsoft .NET Framework 4.0
• Microsoft OLE DB Provider for DB2, available in the SQL Server 2008 R2 or 2012

Feature Pack

Note: Be sure to configure the OLE DB Provider to connect to the mainframe.
See your Microsoft documentation for details.

• Mainframe DB2

Note:

• We support only the mainframe DB2 versions that are currently under IBM
support.

• If you intend to develop applications on your local machine, but deploy
applications to a SQL Server database on a remote machine, you can install
SQL Server Native Client 10.x (or later) for ODBC connectivity on your local
machine instead of installing SQL Server. For information on configuring a
deployment machine, see the section Deploying Native Applications below.

Deploying
Native
Applications

Development
Machine

• Enterprise Developer for Eclipse
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed

Development
SQL Server
Machine

SQL Server 2008 R2 or 2012

Note: This can be the same machine as the development
machine, but is not required to be

Deployment
Machine

• Enterprise Server or Enterprise Test Server installed
• If SQL Server 2008 R2 or 2012 is not installed, you must have

Microsoft SQL Server 2008 R2 or 2012 Native Client installed

If you want to bind your application from the deployment
machine, install the following software in addition:

• Microsoft .NET 3.5 framework, or later
• SQL Server 2008 R2 or 2012 System CLR Types
• SQL Server 2008 R2 or 2012 Shared Management Objects

Deployment SQL
Server Machine

SQL Server 2008 R2 or 2012

Note: This can be the same machine as the deployment
machine, but is not required to be

Database Access - HCO for DB2 LUW

Back to Top
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Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Windows

X X X

XA Switch Module The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

Preprocessor HCO for DB2 LUW supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later

Host Compatibility
Option (HCO)

Host Compatibility Option requires that you have one of the following software
products installed and configured:

• IBM Database Connect
• IBM DB2 LUW Personal Edition or DB2 Express-C
• DB2 LUW Workgroup or Enterprise Edition

You must also install the DB2 Application Development Client (formerly called DB2
SDK) or you will not be able to compile any DB2 programs.

Database Access - SQL Option for DB2

Back to Top

Feature/Platform 32-bit

x86-64 running Windows X

XA Switch Module XDB XA switch modules are provided and are available for the Windows x86-64 32-
bit platform.

Micro Focus Rumba

Back to Top

• On Windows 8, in order to install Micro Focus Rumba you must have the Microsoft .NET Framework 3.5
Service Pack 1 installed.

Additional Software Requirements for Micro Focus Enterprise
Developer UNIX Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file. The following information specifies the third-party software required for
each feature.

• Application server support for JVM COBOL on page 13
• Application server support for interaction with Enterprise Server on page 13
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• Java Development Kit (JDK) on page 14
• Database Access on page 14
• Database Access - COBSQL (Pro*COBOL) on page 14
• Database Access - OpenESQL on page 15
• Database Access - HCO for DB2 LUW on page 16

Application server support for JVM COBOL

Back to Top

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 6.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.6
is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6
is 1.6.027. You can download Oracle's JDK from Oracle's Web site.

Application server support for interaction with Enterprise Server

Back to Top

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following J2EE application servers are supported using the following JDKs:

J2EE Application Servers JDK (vendor) Java EE

JBoss 5 1.5/1.6 (Oracle) 5

JBoss 6 1.6 (Oracle) 6

Oracle WebLogic 10 1.5 (Oracle) 5

Oracle WebLogic 12 1.6/1.7 (Oracle) 6

IBM WebSphere 7.0 1.5 (IBM) 5

IBM WebSphere 8.0 1.6 (IBM) 6

IBM WebSphere 8.5 1.6/1.7 (IBM) 6

The availability of resource adapters for these Application Servers differs between UNIX platforms. The
following table indicates where support is available for each platform:
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Feature/
Platform

JBoss 5 JBoss 6 Websphere
7.0

Websphere
8.0

Websphere
8.5

Weblogic 10 Weblogic 12

AIX 6.1 on
RS6000

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

HP/UX 11.31
on Intel IA64

32- and 64-
bit

32- and 64-
bit

64-bit 64-bit 64-bit 32- and 64-
bit

32- and 64-
bit

Red Hat EL
6.2 on
IBM390

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Red Hat EL
5.5 on AMD
Opteron

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Solaris 11 on
AMD
Opteron

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

Solaris 10 on
SPARC

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

32- and 64-
bit

SuSE SLES
11 SP1 on
IBM390

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

SuSE SLES
11 on AMD
Opteron

32-bit 32-bit 32-bit 32-bit 32-bit 32-bit 32-bit

Java Development Kit (JDK)

Back to Top

Compiling Java Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is
required for compiling Java.

Interface
Mapping Toolkit
(IMTK)

Restriction: This feature applies only when the Enterprise Server feature is
enabled.

The JDK is required for generating Java interfaces from the Interface Mapping Toolkit
or the imtkmake command.

EJBs Use the same JDK vendor and version that is used by the application
server.

After installing the JDK, you need to set up your Java environment.

Database Access

Back to Top

Before you can use Enterprise Developer to develop and deploy SQL applications that use COBSQL, HCO
for DB2 LUW, or OpenESQL, ensure any third-party software prerequisites are installed and the
environment is set properly.

Database Access - COBSQL (Pro*COBOL)

Back to Top
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Note: COBSQL (Pro*COBOL) is supported for native COBOL only.

Availability Feature/Platform 32-bit 64-bit

x86-64 running Red Hat
Linux

X X

x86-64 running SuSE
Linux

X X

IBM System p running
AIX

X X

IBM System z running
SuSE Linux

X X

Itanium running HP-UX X X

x86-64 running Solaris X X

SPARC running Solaris X X

XA Switch
Module

The Oracle XA switch module is provided for COBSQL (Pro*COBOL), and is
available on the same platforms as are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the responsibility
of the RDBMS vendor, rather than Micro Focus. Certification information can be
found within the relevant Oracle documentation. If you have an Oracle MetaLink
account (http://metalink.oracle.com), document # 43208.1 provides details of all
language compilers certified by Oracle for use with their precompilers.

Preprocessors COBSQL supports the following database preprocessors:

• Sybase Open Client Embedded SQL/COBOL Version 11.1 or later
• Oracle Pro*COBOL Version 11.1 (11gR1) or later
• Informix Embedded SQL/COBOL Version 7.3 or later

Compiling On x86 and x86-64 platforms, when compiling with COBSQL for use with Oracle, do
not use the COBSQL directive option NOMAKESYN, since this directive results in
COMP host variables, and on Intel platforms these are incompatible with the native
byte order expected by Oracle.

Executing On HP-UX, to execute an application precompiled using Pro*COBOL (or COBSQL)
after you have created a callable shared object of Oracle DBMS routines, you need
set an environment variable, LD_PRELOAD, to point to the Oracle client callable
shared object, for example:

LD_PRELOAD=$ORACLE_HOME/libdir/libclntsh.so       
export LD_PRELOAD

where libdir is:

• lib32 for 32-bit environments
• lib for 64-bit environments.

A script is available that creates an executable run-time system or a callable shared
object containing Oracle support (applies to UNIX environments only). You can find
the script in the Micro Focus Knowledge Base article titled Building and executing
Pro*COBOL applications on UNIX.

Database Access - OpenESQL

Back to Top
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Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Red Hat Linux

X X X

x86-64 running
SuSE Linux

X X X

IBM System p
running AIX

X X X

IBM System z
running SuSE
Linux

X X

Itanium running
HP-UX

X X

x86-64 running
Solaris

X X

SPARC running
Solaris

X X X

XA Switch
Module

The ODBC One-phase Commit switch module is provided and is available on the
same platforms as are indicated in the Availability section above.

Native COBOL • OpenESQL supports access to relational databases using ODBC 3.0-compliant
drivers

• Refer to your driver vendor's documentation to determine whether your driver is
suitable for use with OpenESQL

JVM Managed
COBOL

OpenESQL supports access to relational databases using JDBC 4.0-compliant JDBC
drivers. In order to utilize JDBC DataSource Objects, you must also install and
configure a JNDI server.

Database Access - HCO for DB2 LUW

Back to Top

Availability Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Red Hat Linux

X X X

x86-64 running
SuSE Linux

X X X

IBM System p
running AIX

X X X

IBM System z
running SuSE
Linux

X X

Itanium running
HP-UX

X
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Feature/
Platform

Native COBOL
32-bit

Native COBOL 64-bit PL/I 32-bit

x86-64 running
Solaris

SPARC running
Solaris

X X

XA Switch Module The DB2 XA switch module is provided and is available on the same platforms as
are indicated in the Availability section above.

Certification of
RDBMS
Precompilers for
Native COBOL

Certification of RDBMS precompilers with Micro Focus products is the
responsibility of the RDBMS vendor, rather than Micro Focus. You can find IBM
document certification information for DB2/COBOL applications within the IBM
Information Center for DB2, in the topic Support for database application
development in COBOL.

Preprocessor HCO for DB2 LUW supports the following database preprocessors:

• IBM DB2 LUW Version 9.5 or later
• IBM DB2 Connect Version 9.5 or later

Host Compatibility
Option (HCO)

Host Compatibility Option requires that you have one of the following software
products installed and configured:

• IBM Database Connect
• IBM DB2 LUW Personal Edition or DB2 Express-C
• DB2 LUW Workgroup or Enterprise Edition

You must also install the DB2 Application Development Client (formerly called DB2
SDK) or you will not be able to compile any DB2 programs.

Restrictions on UNIX and Linux in Third Party Software

Host
Compatibility
Option (HCO)

If you are using the Host Compatibility Option (HCO) with IBM DB2 v9.1 or later, you
may experience the following issues when executing the HCO command-line utilities:

• RTS114 against "hcgetenv"
• SQL1083N The database cannot be created because the database description

block cannot be processed, reason code = "6".

These are due to known issues with IBM DB2 software. Please refer to Micro Focus
Knowledge Base article #25686, located at http://kb/article.aspx?article=2358&p=6,
for further details on how to proceed.

Installing Enterprise Developer for Eclipse

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.
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Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.
• Enterprise Developer is available in different IDE variants, each one of which is targeted by one specific

variant of the development product:

• Enterprise Server - the deployment environment for COBOL applications created with Enterprise
Developer for Visual Studio 2010 or Enterprise Developer for Eclipse

• Enterprise Server 2012 - the deployment environment for COBOL applications created with
Enterprise Developer for Visual Studio 2012

Installing and Licensing Micro Focus Rumba
The Enterprise Developer installer includes Micro Focus Rumba 9.0 which you can optionally install. The
license for Enterprise Developer enables you to use the mainframe components of Rumba (Rumba for
Mainframe).

Before using the Enterprise Developer installer to install or update Rumba, please note the following:

• If you have the full, standalone version of Rumba installed on your machine, it is recommended that you
use the standard ways to upgrade this version to Rumba version 9.0 or later.

It is not recommended to use the Enterprise Developer 2.2 Update 1 setup file to update Rumba as you
may lose your license for the full Rumba version.

• If you are installing Enterprise Developer 2.2 Update 1 onto a machine that does not have Rumba
installed, it is recommended that you select the Rumba option and install this with Enterprise Developer.

This installs the components you need to establish a mainframe 3270 connection (Rumba for
Mainframe) and a 30-day trial license for the full Rumba product. After the 30-day trial period completes
you will still access Rumba for Mainframe components as part of your Enterprise Developer license.

• If you are installing Enterprise Developer 2.2 Update 1 as an upgrade to an existing licensed installation
of Enterprise Developer that is using an authorization code issued before Enterprise Developer 2.1
Update 1 (released in April 2013), it is recommended that you do not update the Rumba components
previously installed with the earlier version of Enterprise Developer.

If you do want to update Rumba, then select this during the 2.2 Update 1 installation and then contact
Micro Focus SupportLine and ask for the Enterprise Developer 2.2 Update 1 authorization code. This
will replace your existing 2.1 authorization code and will enable the updated version of Rumba.

Installing as an Upgrade
This release will update an existing installation of Enterprise Developer 2.2.

• Before installing this release as an upgrade to an existing installation of the previous version 2.2 of the
product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might result in files
not being installed.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.
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Installing
Note:

• Before installing, check Installation Restrictions and Requirements.
• See Installing as an Upgrade first for important information when upgrading an existing installation

of Enterprise Developer.
• This version of the product is a full install.

These are the steps to install this product:

1. Run the ede_221.exe file and follow the wizard instructions to complete the installation.

By default, this installs Enterprise Developer in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer folder and installs a full version of Eclipse 3.8, with the Micro Focus plugins
already installed, in the C:\Users\Public\Micro Focus\Product Name\eclipse directory.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.

Installing Silently on Windows
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

To install silently use the following command:

start /wait install-file.exe /q [parameters]

where install-file for the following products is as follows:

Enterprise Developer ede_221.exe

To see what parameters you can use, execute the following from the command line:

install-file /help

See the Examples section further in this topic for examples of some of the parameters you can use.

After the application installation is complete you can install the license silently by executing the following
commands:

If you have access to the
Internet and an
authorization code

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet 
Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term activate AuthorizationCode
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For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files
\SafeNet Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term activate AuthorizationCode

If you don't have access to
the Internet but have a file
from Micro Focus that
contains the license string

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet 
Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term install -f FileName

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files
\SafeNet Sentinel\Sentinel RMS License Manager\WinNT
\cesadmintool" -term install -f FileName

where FileName is the name of the text file that contains all the license
strings to be used.

Directory considerations

• You must have read and write access for every directory accessed during the installation.
• You can override the default installation folder using the INSTALLDIR parameter:
• If a path in a definition contains spaces, then the path must be preceded by a backslash and double

quotation mark (\"). For example:

INSTALLDIR=path
INSTALLDIR=\"c:\MyProduct\" 
INSTALLDIR=\"c:\Program Files\Micro Focus\My Product\"

• Installing creates a log file in %temp%\LogFilename by default. To change the location or name, use
the /log parameter on your Setup command line and specify the path and file name, for example:

The default names for the log files are as follows:

Micro_Focus_Enterprise_Developer_for_
IDE_date.log

for the Enterprise Developer wrapper

EnterpriseDeveloperx??
_install_log.txt

for Enterprise Developer, where ?? is "86" for 32-bit
systems and "64" for 64-bit systems

lmsetup_install_log.txt for Micro Focus License Administration

• The log filename and folder name cannot contain spaces
• The log file folder must exist before beginning the silent install

Examples

• To silently install Enterprise Developer into a directory other than the default:

start /wait ede_221.exe /q InstallFolder=c:\DirectoryName

• If you want to silently install the Eclipse IDE in a location other than the default, execute:

start /wait ede_221.exe /q InstallFolder2=c:\EclipseInstallDirectory

• To silently install Rumba during the silent install of Enterprise Developer:

start /wait ede_221.exe /q RumbaCheckbox=1

Installing into different Eclipse packages
Micro Focus Enterprise Developer uses Eclipse 3.8, but it will also work with Eclipse 3.7.1. If you want to
use Enterprise Developer in Eclipse packages based on version 3.7.1, you must also install the Enterprise
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Developer update site, and the RSE and AspectJ plugins. The following sections show how to install into
an existing installation of Eclipse 3.8 and into Eclipse 3.7.1.

Important: We recommend you back up all existing Eclipse configuration files first.

If you have Java 7 or Java 8 installed on your machine, see the Java Support considerations in the
Known Issues and Restrictions section in your product help.

Installing into Eclipse 3.8

1. Install Enterprise Developer.
2. Copy the required Enterprise Developer resources to your existing Eclipse as follows:

a. Extract the contents of the following .zip files in %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer\installer to a temporary folder:

ajdt_2.2.2_for_eclipse_4.2.zip

AWMUpdateSite.zip

dtp_1.10.2.zip

emf-runtime-2.8.3.zip

emf-transaction-runtime-1.6.0M7.zip

emf-validation-runtime-1.6.0M7.zip

GEF-runtime-3.8.2.zip

org.eclipse.graphiti.site_0.9.2.201302110913.zip

RSE-runtime-3.5-GA.zip

wtp4x-R-3.4.2-20130208151217.zip

xsd-runtime-2.8.3.zip

b. Extract the contents of the following .zip files in %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer into the same temporary folder:

AMBUpdateSite.zip (if you have installed the AppMaster Builder AddPack)
EDUpdateSite.zip

UpdateSiteMainframeExplorer.zip

c. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins.
d. Rename each of the following folders:

• From ajdt_2.2.2_for_eclipse_4.2 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
• From EDUpdateSite to COBOLUpdateSite
• From dtp_1.10.2/eclipse to DTPUpdateSite
• From emf-runtime-2.8.3/eclipse to EMFUpdateSite
• From emf-transaction-runtime-1.6.0M7/eclipse to EMFTransactionUpdateSite
• From emf-validation-runtime-1.6.0M7/eclipse to EMFValidationUpdateSite
• From GEF-runtime-3.8.2/eclipse to GEFUpdateSite
• From org.eclipse.graphiti.site_0.9.2.201302110913/eclipse to

GraphitiUpdateSite

• From wtp4x-R-3.4.2-20130208151217/eclipse to WTPUpdateSite
• From xsd-runtime-2.8.3/eclipse to XSDUpdateSite

e. Edit the eclipse.ini file in <your existing Eclipse>\eclipse:

• Add

Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/
plugins/org.eclipse.equinox.weaving.hook_1.0.200.I20130127-2000.jar

as a property at the end of the file

Micro Focus Enterprise Developer 2.2 Update 2 for Eclipse Release Notes | 21



• Add

Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/
org.eclipse.equinox.weaving.aspectj_1.0.200.I20130127-2000.jar@2:start,
reference:file:
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.301.v20120914-163612.jar@1

as a property at the end of the file.

Note: There is an eclipse.ini file in the %ProgramFiles(x86)%\Micro Focus
\Enterprise Developer\installer folder but it might conflict with the existing
eclipse.ini in your existing installation. You need to decide which pieces are relevant.

3. Restart Eclipse at the command line with the -clean option.

Installing into Eclipse 3.7.1

1. Install Enterprise Developer.
2. Copy the required Enterprise Developer resources to your existing Eclipse as follows:

1. From the http://www.eclipse.org website, locate the following packages from the project download
archive:

• ajdt_2.2.2_for_eclipse_3.7.zip

• RSE-runtime-3.3.zip

2. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins.
3. Rename each of the folders:

• From ajdt_2.2.2_for_eclipse_3.7 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite

4. Move the contents of the <your existing Eclipse>\eclipse\dropins\RSEUpdateSite
\eclipse folder up a level (that is, to <your existing Eclipse>\eclipse\dropins
\RSEUpdateSite) and delete the empty folder.

5. Extract EDUpdateSite.zip from %ProgramFiles(x86)%\Micro Focus\Enterprise
Developer into <your existing Eclipse>\eclipse\dropins\COBOLUpdateSite.

6. You might need to edit the eclipse.ini file in <your existing Eclipse>\eclipse:

• Add

-Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/ 
plugins/org.eclipse.equinox.weaving.hook_1.0.200.I20120427-0800.jar 

as a property at the end of the file
• Add

-Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/ 
org.eclipse.equinox.weaving.aspectj_1.0.100.I20120427-0800.jar@2:start,
reference:file: 
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.200.v20110502-1955.jar@1:sta
rt

as a property at the end of the file
3. Restart Eclipse at the command line with the -clean option.

Installing Micro Focus Enterprise Developer UNIX Components
Note:
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• Micro Focus Enterprise Developer UNIX Components is only available with an Enterprise
Developer or Enterprise Developer for IBM zEnterprise license and is not available with an
Enterprise Developer Personal Edition license.

• If you are installing on Solaris, please read UNIX Installer Issues first.

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

These are the steps to install this product:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_2.2_update1_platform

2. Run the installer from the Process User ID login:

./setup_entdev_2.2_update1_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_2.2_update1_platform -installlocation="full path of new 
location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:
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-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

./setup_entdev_2.2_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

1. To set up your product, execute:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application installation is complete you can install the license silently by executing the following
commands:

If you have access to the Internet
and an authorization code

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -authorize AuthorizationCode
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If you don't have access to the
Internet but have a file from Micro
Focus that contains the license
string

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -install FileName

where FileName is the name of the text file that contains all the
license strings to be used.

UNIX and Linux Installer Issues

Installing on
Linux

On Linux, the 32-bit version of Java is required to install and use Enterprise Developer
for Eclipse. When you start the installation, if the 64-bit version of Java is already
installed on your Linux machine, you might not be able to install Enterprise Developer.
This is a known issue with the Oracle Java installers for Linux which prevent you from
installing both the 32-bit and the 64-bit versions of Java on the same machine. To work
around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

• Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in /usr/local/
java.

• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Enterprise Developer.

License
Infrastructure
Installer

• On some Solaris platforms, you can receive the following error message when
SafeNet license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
behaviour – for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the
following contents:

----------- start of /usr/lib/systemd/system/
MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com
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    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/
MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root
privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the
machine is booted.

enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
OS.

License
Server

You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Configuring the Remote System Explorer Support

The remote development support from the Eclipse IDE relies upon Enterprise Developer running on the
UNIX machine and handling all requests from the IDE for building and debugging programs. Enterprise
Developer provides a UNIX daemon, the Remote Development Option (RDO) daemon, which initiates the
RDO as Eclipse clients connect to it. Whichever environment is used to start the RDO daemon will be
inherited for all servers and hence all build and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated from one of the Eclipse clients, the environment used will be
inherited from whatever was used to start the daemon. A typical example of the kind of environment that
might need to be set up would include database locations and settings for SQL access at build/run time.
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Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use

to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command with superuser authority:

$COBDIR/remotedev/stoprdodaemon <port>

Repairing on UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Installing Mainframe Access Server
Note: Mainframe Access Server is only available with an Enterprise Developer or with an Enterprise
Developer for IBM zEnterprise license and is not available with an Enterprise Developer Personal
Edition license.

Introduction

The installation process for Mainframe Access Server (MFA) uses a single FTP operation to transfer all of
the mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
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FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.

Requirements

• IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher
• Two APPLIDs, two TCP/IP ports
• Availability of APF security authorization support personnel
• Access to a network share with acceptable space for source and data, as well as the ability to access

the IP address and ports used to access MFA
• The following installation-specific variable information:

Variable Description

drive

userid TSO user-ID for FTP to your mainframe

pswd TSO password for the FTP user-ID

your.mainframe.name TCP/IP host name or IP address of your mainframe

prodhlq A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

Important: The installation of a new version of MFA creates new product run-time data sets before
the upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can be
used for fallback. If you prefer to retain your former production library names and re-use your
existing prodhlq, rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFM0001I and MFM0014I on the syslog and XDBOUT sysout data set show the maintenance
level at startup. You may need to know what level you are upgrading from when you complete post-
installation customizations for this upgrade.

Install Mainframe Access Server

In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlq.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlq.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:

DSORG=PO                   <=== PDS (partitioned data set)
RECFM=FB                   <=== record format fixed and blocked
LRECL=80                   <=== 80 character record size
BLKSIZE=3120               <=== 3120 character block size
SPACE=(3120,(3500,500,50)) <=== allocate blocks (BLKS) size 3120
                                3500 primary blocks
                                500 secondary blocks
                                50 directory blocks

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.
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a. Start FTP:

C:\>ftp your.mainframe.name
Connected to your.mainframe.name.
220-FTPD1 IBM FTP CS/390 VxRy at YOUR.MAINFRAME.NAME, hh:mm:ss
220 Connection will close if idle for more than 5 minutes.
User (your.mainframe.name:(none)): userid
331 Send password please.
Password: pswd
230 userid is logged on. Working directory is "userid.".

b. Change the working directory on the mainframe to be the upload library that you allocated:

ftp> cd 'prodhlq.UPLOAD'
250 The working directory "hlq.UPLOAD" is a partitioned data set.

c. Set file transfer type to binary:

ftp> binary
200 Representation type is Image

d. Set FTP prompting off to transfer all files without interruption:

ftp> prompt
Interactive mode Off.

e. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:

ftp> mputdrive:\upload\f*
200 Port request OK.
125 Storing data set prodhlq.UPLOAD(Fxxxxxxx)
250 Transfer completed successfully.        
ftp: xxxx bytes sent in x.xx seconds (xxx.xx Kbytes/sec)
.
.
.

f. When mput has transferred all files the ftp> prompt appears. End the FTP connection:

ftp> quit
221 Quit command received. Goodbye.        

g. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the
\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.

4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.

5. Start Mainframe Access Server.

After installation

Since the program libraries can change between versions, it is necessary to either create new procedures,
or back up the old procedures, and at least modify the DSNQUAL=prodhlq within your MFA sample started
task procedures as provided by Micro Focus. The prodhlq.LOADLIB and prodhlq.SASC.LINKLIB must both
be authorized.

Verify successful maintenance application by checking the Mainframe Access Server startup message:

MFM0001I: Mainframe Access V4.00 (BASE ) is active

The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:

MFA303I MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS...

When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.
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MFA sample MFA started task

MFAS *new* sample MFAS started task for Data Connect

MFAAS sample MFAAS application server started task

MFAVTAM sample MFA VTAM definitions

PARMS sample PARMS for MFA started task

PARMSAS sample PARMSAS for MFAAS started task

SERVERS sample SERVERS configuration for MFA

UPQUICK configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
need to modify the MFAS started task JCL since the module names for Data Connect have been changed
to allow co-residence within the same authorized library as MFA.

Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.

Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Installing the mainframe components

Mainframe z/Server

The mainframe z/Server is a z/OS server that supports the Eclipse mainframe integration, and is provided
with Enterprise Developer for IBM zEnterprise. z/Server needs to be installed before mainframe access is
enabled.

Refer to the document z/Server Installation Guide for instructions on how to install Enterprise Developer's
mainframe components.

To define
default z/
Server
connections

Enterprise Developer supports the configuration of default connections. Default
connections can be defined by creating a file called defaultZConnection.ini in the
Eclipse folder of your Enterprise Developer installation.

The contents of this file must follow these syntax rules:

• Every line must contain one attribute or start with # (Comment)
• Every connection must start with >CONNECTION and end with >END_CONNECTION
• Every connection must be defined with following attributes:

NAME The name of the connection - this must be unique

HOST_ADDRESS The physical address of the host (for example 192.168.1.1,
localhost)

PORT The port of the z/Server (scheduler)

DESCRIPTION The description of the connection - this can be left blank

A sample file is included in the installation.

When Enterprise Developer successfully parses the defaultZConnection file, it
creates a z/OS connection in the Remote Systems View for every configured default
connection.
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Important: Enterprise Developer reads the defaultZConnection file only
once for each workspace. This means that any changes relating to default
connections will not apply to existing workspaces that have already been used.

Assuming you have the appropriate Enterprise Developer for IBM zEnterprise license,
after installing z/Server you should verify the connectivity.

To verify
mainframe
connectivity

1. Start Eclipse.
2. Ensure the Team Developer perspective is loaded. If it is not visible, select Window

> Open Perspective > Other > <Team Developer>.
3. Right-click in the Remote Systems view and select New > Connection.
4. Select "z/OS" from the connection list and click Next.
5. Enter the TCP/IP address or name of your mainframe system and enter a connection

name that will be displayed in the view. Click Next.
6. Enter the correct connection port and the default encoding parameters. Ask your

system administrator if you do not know the correct parameters.
7. Click Finish. The z/OS entry is added to the view.

To verify the
client host
connection

1. Start Eclipse and switch to the Team Developer perspective.
2. Expand the z/OS connection entry in the Remote Systems view. If the z/OS entry is

not shown in this view, verify the client installation process first.
3. Right-click on the MVS entry and verify, or customize, the port number of the z/

Server server (the default is 1111).
4. Right-click on the MVS entry and select Connect.
5. Enter your mainframe user ID and password and click OK. After a successful

connection the color of the icons changes to green.
6. Right-click again on the MVS entry and select Disconnect to disconnect from the

host system.

Mainframe Access server (MFA)

Mainframe Access is the OS/390 and z/OS server for Micro Focus development environments. It is a
common component providing access to host resources for environments. One installation of Mainframe
Access can support all of these products, providing connectivity to any number of DB2, IMS, and CICS
systems located anywhere in an enterprise. It can also provide access to JES facilities, VSAM data sets,
non-VSAM data sets, and data controlled by external library management products such as Panvalet,
Librarian and Endevor.

Features include:

• The Drag and Drop utility allows you to transfer files using drag and drop methods, between the
mainframe and the PC environments.

• The Remote Job Step Execution (RJSE) facility enables execution of one or more steps of a job on a
remote z/OS host. It automatically uploads and downloads required files as necessary with an end
result the same as when all steps are executed locally.

• Compare and Synchronization Monitor allows you to compare mainframe data sets against workstation
directories. Where differences occur, you can synchronize the information. This can occur in either
direction, or both directions. Typically, you would download mainframe partitioned data sets to a
workstation directory.

• You can use SourceConnect to map a PC drive to a mainframe dataset. You can then access
mainframe files and resources from a PC, or from applications running on a PC.
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Installing Application Workflow Manager into IBM Rational Developer
for System z (RDz)
Provides instructions about how to install the Application Application Workflow Manager delivered with
Enterprise Developer Connect into IBM's Rational Developer for System z (RDz).

The Application Workflow Manager component provides all the capabilities and tools to develop and
maintain Application Workflow models. These models allow you to integrate mainframe tools and
processes directly into Enterprise Developer.

An Enterprise Developer Connect license enables you to install and use the Application Application
Workflow Manager component in the RDz product. The following instructions show how you can do this:

1. Install Enterprise Developer and a license for Enterprise Developer Connect.
2. Copy the AWMUpdateSite.zip file from %ProgramFiles(x86)%\Micro Focus\Enterprise

Developer\installer to a temporary folder.
3. Start the RDz product with administrator's privileges.
4. In the IDE, click Help > Install New Software.
5. On the Install dialog box, click Add on the row for the Work with field.
6. On the Add Repository dialog box, click Archive.
7. Navigate to the location of the AWMUpdateSite.zip file, select the file, click Open and then click OK.

This loads the Application Workflow Manager component in the Install dialog box.
8. Under the Application Workflow Manager node, check the Application Workflow Manager and

AWM RDz Integration items.
9. Click Next and follow the wizard instructions to complete the installation.
10.Restart RDz if prompted to do so.

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
3. Click Window > Reset Perspective.
4. Click OK.
5. Reapply any customizations.

Note: For applications created with earlier Micro Focus products, note the following:

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Enterprise Developer. For more
information, read the section Upgrading to Enterprise Developer for Eclipse in the
product Help.

Installing X Windows on Windows
Some features of Enterprise Developer for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in
your Enterprise Developer installation. By default this will be in the %ProgramFiles(x86)%\Micro
Focus\Enterprise Developer\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.
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Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Enterprise Developer and
Micro Focus License Administration. Uninstalling only Enterprise Developer does not automatically
uninstall the Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

UNIX

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper2.2.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The Enterprise Developer Personal Edition option is not available with this release. You can use
the Personal Edition with Enterprise Developer 2.1 Update 1 - you can register for it on the 
Enterprise Developer Personal Edition section on the Micro Focus Web site.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Enterprise
Developer help.

To start Micro Focus License Administration

Windows

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:
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1. Start Enterprise Developer.
2. Click Help > Micro Focus > Product Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Finish to install the license.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection

Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter

Authorizing your product when you don't have an Internet connection

Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Windows

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.
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The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

UNIX

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.

New Features in Enterprise Developer 2.2 Update 1
This release provides enhancements in the following areas:

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

AppMaster Builder

This release provides updated AppMaster Builder support that integrates more fully into the Eclipse IDE. In
addition, the following enhancements have been added:

• Code generation and compilation in an Eclipse COBOL project
• Enhanced Program Painter
• Enhanced Job Queue
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Assembler Support

This release provides Assembler support from within the IDE. Features include:

• Support for creating Assembler programs (.mlc extension), macro files (.mac or .cpy extenstions) or
Assembler linker files (.lin) from within the IDE.

• Support for building Assembler programs and for linking Assembler linker files from within the IDE. You
can choose to exclude certain files from the build.

• Assembler editors for Assembler and macro files - includes content assist for reserved words and
colorization.

• Support for using Ant for building .asm, .mlc and .cap files and for linking .lin files.
• IDE support for configuring the Assembler compiler and linker options on project, build configuration

and file levels.
• Configuring the macro paths.

Btrieve Support

Support for the Btrieve file handling system from Pervasive Software Inc. has been added into Enterprise
Developer.

Support is restricted to native COBOL, in a Windows environment.

COBOL Source Information

The Quick Browse option is now available as a context menu command in the editor.

Compare and Synchronization Monitor

Note: This feature is only available in a Windows environment.

With the release of Enterprise Developer 2.2 Update 1, the Compare and Synchronization Monitor has
been updated to version 2.

Version 2 is greatly improved in terms of performance, especially during initial checkout of partitioned data
sets or when synchronizing a large number of members. Also, the user interface has been improved, and
some of the functions available in the old version have now changed or become obsolete.

Compiler Directives

The following Compiler directives have been added in this release:

ILPARAMS Determines the way in which you call a method that contains an array as its last receiving
parameter.

INIT-BY-
TYPE

Initializes Working-Storage Section data items to a default value, according to their type.

• Alphabetic, alphanumeric, alphanumeric edited, and numeric edited items are initialized
to spaces.

• Numeric items are initialized to zero.
• Pointer items are initialized to null.
• Index items are initialized to the value 1.

Database Access

The following new features have been added as part of database access support:

HCO for DB2
LUW

• Support added for DB2 LUW version 10.5.
• Enhanced RETURN-CODE processing.
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• The HCO DDL processor now accepts column names with a length greater than 18
characters.

• The HCO Import Data tool now processes CLOB data less than 32K in size.
• The HCO Import Data tool can now convert DSNTIAUL import files to delimited

format, enabling the actual import to be done by DB2 LUW IMPORT and LOAD
utilities. This is done using the new SAVEDEL and CHARDEL parameters.

HCO for SQL
Server
(HCOSS)

• Support for the mainframe SET CURRENT SQLID statement.
• Support for the mainframe LEFT and RIGHT scalar functions.
• Data Migration tools now support the mainframe ALIAS and SYNONYM objects.

OpenESQL • Enhanced internationalization support for UNICODE, DBCS and MBCS.
• Enhanced GET DIAGNOSTICS statement support.
• Enhanced LOB support for CLOB, BLOB and DBCLOB data types.
• Enhanced IDE support for OPTION directives.
• Now provides support for the creation of save points and rolling back to save points.

XA Switch
Modules

Restriction: This feature applies only when the Enterprise Server feature is
enabled.

• New two-phase commit module for SQL Server based on Microsoft's XA switch.
This provides support for xa_recover.

• Support for DB2 LUW version 10.5.
• Support for Oracle version 12.1.

Eclipse IDE

Assigning
memory to
Linkage Section
items

If the debugger steps on a line with an unassigned linkage item (for example, if you
are debugging only a part of your application and no memory has been allocated to
that linkage item), debugging terminates. To assign linkage to that data item and
continue debugging, you need to select the data item, right-click it and click Inspect
COBOL. When prompted, confirm and assign a value to the data item. Alternatively, to
assign linkage, you can right-click the data item in the Variables view and click
Change Value.

Debugging
Windows
Services

It is now possible to debug Windows services. You must be logged on to the console
of the computer running the service and can debug either using just-in-time debugging
and a CBL_DEBUGBREAK call, or using library routines and a "COBOL Wait for
Application Attachment" debug session having added a call to CBL_DEBUGBREAK or
CBL_DEBUG_START to the application.

Indicating that a
file is a
copybook or a
COBOL
program

In COBOL Explorer, you can now use two new file context menu commands to
indicate that a COBOL program is a copybook (Transform Program to Copybook)
and that a copybook is a COBOL program (Transform Copybook to Program). You
may need to use these in situations when you imported existing COBOL source code
in the Eclipse IDE and some of the files were incorrectly identified as either a
copybook or a COBOL program.

Enterprise Server Integration in the IDE

You can now use the context menu for the servers in Server Explorer to enable the display of the
Enterprise Server log information in the Console view.

Environment Variables

The following environment variable has been added in this release:
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strictvsam strictvsam enables strict mainframe emulation when processing VSAM files.

When set to ON and running under mainframe emulation, file status 37 is returned for an
existing VSAM file when opened for OUTPUT if the file has data or previously had data
written to it, or if the file is of a different format to the file on disk. When set to OFF, file status
0 is returned and a new file is created when an existing VSAM file is opened for OUTPUT.
This variable is set to OFF by default.

Fileshare Recovery

Recovery of Fileshare data files has been enhanced.

Rollback recovery is a faster process that aims to fix the files from their failed state.

This process cannot be used in all scenarios, but a new user exit has also been introduced that allows you
to programmatically control which files you wish to recover with this process.

Hot backups are also a new introduction, which allow you to perform a backup without having to shut down
Fileshare.

Line Numbering for COBOL Programs

This release provides options for auto-inserting or removing line numbers in source files open the editor.
Features include:

• COBOL numbering - line numbers are inserted in the sequence area of the code (columns 1 - 6),
starting at 000100 at the first line, and incrementing by 100.

If it recommended that you use COBOL numbering only if your files are in fixed or variable source
format.

• Standard numbering - line numbers are inserted immediately to the right of area B, in columns 73 - 80,
starting at 00001000 at the first line, and incrementing by 1000.

If it recommended that you use Standard numbering only if your files are in fixed format.

• The Renumber and Unnumber commands available from the context menu in the editor.

Local Catalog

From within Server Explorer in the IDE, you can add one or more local catalogs, and then use them in
conjunction with Drag and Drop to drag down data set items from your mainframe, edit them and then
move them back to the mainframe or to your testing environment.

IMTK

You can now use the Interface Mapping Toolkit to create Web Services and Java Interfaces for remote
COBOL projects.

Working with the Mainframe

This release includes the “Launch ISPF” functionality as a technical preview. This feature is supported only
under z/OS 1.13.

Mainframe Emulation

Previously, MGMTCLAS was supported by simply saving it on the catalog record when a dataset was
allocated in JCL using the MGMTCLAS parameter on the DD statement. Starting with this release, you can
use batch jobs to define MGMT classes and to specify the EXPIRE AFTER time (in days).
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Mainframe Subsystem

New editors Enterprise Developer now provides special editors for REXX, TSO CLIST and
Easytrieve programs. The editors include colorization and content assistance. Syntax
checking is not available.

Casspool
performance
enhancement

As part of an enhancement to improve performance when browsing the spool queue of
an Enterprise Server, you must update the casspool file for any Enterprise Server
created before Enterprise Developer 2.2 Update 1 before you can submit jobs to it.

To update the casspool for each Enterprise Server, from a command prompt, run
fixcasspool.bat (Windows) or fixcasspool.sh (UNIX), located in %COBDIR%
\bin and %COBDIR%\bin64 (Windows) or $COBDIR\bin (UNIX), using the following
syntax:

fixcasspool.bat casspool.dat backup.dat

or

fixcasspool.sh casspool.dat backup.dat

Where:
casspool.dat

The spool file, located in the same directory as the Enterprise
Server's system catalog, that will be updated.

backup.dat
A file that will be created with a backup of the old casspool.dat
file. If backup.dat already exists, the update is not run.

If you do not update casspool and attempt to start Enterprise Server, the following
messages are displayed in the console:
JES000011E Batch Spool File Error; Status [39]

JES000130E Note JES000011 Error - New casspool indexes may need
generating. See error description in product docs

Managed COBOL

Enterprise Developer now provides support for Java managed beans (MBean) in JVM COBOL code that
enable you to manage and monitor RunUnits, and to identify certain issues such as leaks and long-running
RunUnits.

• You can enable an MBean only for a particular RunUnit level or for all RunUnits you create.
• You can view and use MBeans from programs such as Oracle's Java Mission Control or JConsole.
• MBeans include the LogicalRunUnitCount and LiveRunUnitCount attributes that enable a visual

indication of how many RunUnits are live. If the values of these two attributes are different, this might
indicate some issues.

This release also includes the following tutorials for JVM COBOL:

Deploying JVM
COBOL to an
Application Server

Using some ready-made sample projects, this tutorial guides you through
implementing your JVM COBOL code into an Enterprise JavaBean (EJB), then
deploying it to a JBoss application server. Instructions are also included on how
to deploy the application to WebSphere and WebLogic application servers.

Managed COBOL Syntax

This release includes the following enhancements to the managed COBOL syntax:
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Specifying parameters in
the method signature

You can now specify passing parameters and returning items in the method
signature, instead of using a Procedure Division header. This applies to
methods, indexers, iterators, constructors and delegates.

CONSTANT keyword Use the CONSTANT keyword on a field to protect it from being altered.

Operations on string
fields

You can now use the STRING, UNSTRING and INSPECT statements on
fields of type string.

PL/I

PL/I support within the IDE now includes the following enhancements:

• Support for new built-in functions

The PL/I Compiler and Runtime now support the following new built-in functions:

DAYS
DAYSTODATE
SECSTODATE
SECS
WEEKDAY
DAYSTOSECS
ONSUBCODE
REPATTERN
IAND
IOR
INOT
OMITTED
XMLCHAR

This provides an improved functionality and a greater language compatibility when you migrate
applications from a z/OS environment.

• Support for %OPTION in the PL/I macro preprocessor

You no longer need to modify application code that uses %OPTION in order for it to compile
successfully.

• Support for QUOTE() and COMMENT() built in functions.

This enables the use of PL/I macros that generate code using these built-in functions.
• Support for IBM Style %INCLUDE(s) that utilize PDS name as part of include file names.

The PL/I macro preprocessor now parses the %INCLUDE syntax of the form shown below and utilizes
the –isuffix and –ipath Compiler directives to locate the “member”.

%INCLUDE MYPDS(MYMEMBER);

This provides an improved language compatibility with the application code without the need to modify
the original underlying source code.

• Support for PL/I AREA data items up to 2Gb.

Open PL/I now supports the declaration and usage of variables of type AREA up to 2Gb in size. This
provides you with improved functionality and greater language compatibility when migrating applications
from a z/OS environment as there is no need to modify the code in order to deal with a maximum area
size of 32Kb.

• Enhanced compatibility with the DISPLAY() REPLY() syntax.

The PL/I Compiler and runtime now provide a DISPLAY() REPLY() syntax that is no longer dependent
upon the use of the SYSIN and SYSOUT DD’s and that no longer causes behavioral differences if
stream IO to SYSIN/SYSOUT is intermingled with programs using DISPLAY() REPLY().
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• Support for big-endian style bit strings on little-endian platforms.

Using a new Compiler directive –bitsltr to compile programs that have logic that is dependent on big-
endian bitstring ordering enables you to utilize the code unchanged on Open PL/I little-endian platforms
(such as Windows, Red Hat Linux, SUSE Linux). This enables you to migrate applications that make an
assumption about bit ordering on the underlying operating system or hardware and to run them
unchanged.

• Support for the –initcall Compiler directive.

Compiling a PL/I program with the –initcall directive causes the specified program to be invoked prior to
any user logic. This enables you to customize your environments and do things such as tracking which
routines have been invoked, detect memory corruption prior to routine startup, establish database
connectivity.

• Support for the “F” option in PLIDUMP.

A PLIDUMP which was generated using the “F” option will now attempt to list all known information
about files which have been accessed during the execution of the program and includes information
about the last IO operation, key values, and a dump of buffers, if available. This enables you to identify
more easily the cause of file-related failures and what file operations were in progress at the time of
failure.

• Early Adopter support for PL/I data structures Data File Tools.

In the IDE, you can now generate a PL/I structure map (.str) which can be utilized by the Data File Tools
utility to generate a formatted layout for a PL/I Data File. The PL/I data structure must be compiled in
advance with the -adt Compiler directive. This enables you to see what is in each field within a PL/I data
file record, and to modify them in a logical way without having to know the offset, length and raw format
of the data item.

• Support for PL/I debugger notification for ON Unit invocation.

You can now request that the debugger stops when a PL/I ON Unit is about to be triggered. This
enables you to locate the ON Unit, establish appropriate breakpoints within the ON Unit and determine
the cause of the ON Unit being triggered.

• Support for PL/I debugger notifications for the load of shared libraries and .dll files.

You can now request that the debugger issues a notification when a shared object or a .dll file has been
dynamically loaded. This enables you to stop a program when a dynamic program has been loaded and
to establish the appropriate breakpoints, watch lists, etc.

• Alternative Index Performance Improvements for the CASSPOOL command.
• Support of the SHAREOPTIONS property in a VSAM cluster.
• Support for setting directives automatically for PL/I files.

In Eclipse, click Window > Preferences > Micro Focus > PL/I > Directives Determination.
• A new page in the project and file properties enables you to set SQL directives on PL/I source files.

Preprocessors

A guide for third-party vendors and administrators showing how to integrate additional preprocessors with
Enterprise Developer is now available in the product help in the General Reference > Integrated
Preprocessor Interface section.

Project and Item Templates

Support is now available for using existing projects and files as custom templates to create new projects
and files. You create and configure projects that include the files and settings you would like to use as
templates.

Remote Connections

Enterprise Developer now provides a new connection type, Micro Focus DevHub using SSH, that uses a
Secure Shell daemon process to launch a server on the remote host.

42 | Micro Focus Enterprise Developer 2.2 Update 2 for Eclipse Release Notes



You can use this type of connection when the UNIX machine you are connecting to uses LDAP
authentication which is not supported by the DevHub daemon.

Using this connection also means you do not need to run the DevHub daemon process with root privileges.
It also gives you greater flexibility in setting environment variables needed for building or debugging on the
remote server.

Rumba Integration with Eclipse

This release provides enhanced integration with the Micro Focus Rumba application for running and
debugging Mainframe Subsystem applications that require a TN3270 emulator to run. You can now
configure Eclipse to launch a Rumba mainframe display embedded in the IDE or a mainframe session of
Rumba Desktop.

Run-time Launch Configuration Files

Note: This feature is only supported in a Windows environment.

Use a run-time launch configuration file to ensure an application can be launched when it is deployed in a
separate location to the run-time system (in the case of dynamically bound applications), or when the
licensing daemon is not already running.

Terminfo Files

The following terminfo files have been added:

• ansi80x25 - this is based on the old ansi file. A newer version of ansi exists in this release that has no
function key support, which is consistent with ansi terminfo files on various other UNIX platforms. If you
currently use ansi and require function key support, you should instead set the TERM environment
variable to ansi80x25 to continue previous behavior.

• xterm-color and kterm-color - these are now available on all UNIX platforms - previously, they were only
available on Linux.

• aixterm-old (AIX systems only) - this has similar capabilities to the AIX OS terminfo file of the same
name. It differs from the existing aixterm file, because it has no line drawing capability. Line drawing is
only possible with aixterm if it is displayed on an appropriate display (X server).

• vt220-w - this is the wide (132-column) version of the vt220 file, and is based on the vt100-w file. For
more information, see Wide Terminal Mode in the documentation referenced at the bottom of this
section.

There have been a number of additions and fixes to existing terminfo files; refer to the Terminfo Database
and Terminal Devices section of the documentation for full details.

There have also been a number of terminfo files that have been removed; refer to the Backward
Compatibility section for a complete list.

Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Application
Workflow
Manager

In an Application Workflow Manager modelled action, you retrieve a file from the
remote zOS system directly into a COBOL project, you must set the text file encoding
of the COBOL project to UTF-8 in the project properties in order for the Compiler to
correctly process the source code. To set the encoding, in the project properties of
the COBOL project and on the Micro Focus > Project Settings > COBOL, specify
the source-encoding(utf8) Compiler directive in the Additional directives field.
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CICS • An EXEC CICS DELAY statement may sometimes produce a difference of one
second.

COBOL
Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement
following the statement that modifies the data on which that watchpoint is set.

Debugging There is an issue with "Wait for attachment" when you use Enterprise Developer for
Eclipse to debug applications that run on some UNIX/Linux platforms. Eclipse
connects to the debugger on the remote machine, but might not attach to the process
to debug the code.

To work around this issue, ensure that on the remote machine the TMPDIR
environment variable is unset or has the same value for both Micro Focus Enterprise
Developer UNIX Components server and for the running process you wish to debug.
The Micro Focus Enterprise Developer UNIX Components server is the server which
you started either directly with the $COBDIR/remotedev/startrdoserver script or
indirectly using the daemon which is started with the $COBDIR/remotedev/
startrdodaemon script.

To check the variable used by the Micro Focus Enterprise Developer UNIX
Components server:

1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click

Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and press

Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same as
the one used by the process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot
be changed in the remote shell and must be set before you start the
daemon or server.

Documentation • A problem in Enterprise Developer results in an error when you try to submit the
JCL file as described in the tutorial Getting started with Enterprise Developer for
Eclipse in the product help. To work around this, when you follow the steps in the
topic Importing the BankDemo project and adding the source files, execute the
step Setting Compiler directives before executing the step Specifying the
copybook paths for the project. This ensures the BankDemo projects is rebuilt.
The instructions have been updated in the Micro Focus Infocenter version of the
help.

• A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with
searching and indexing the help in the Eclipse help viewer if you are running
Eclipse on a machine that has this version of JRE installed.

Database
Access

If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual
COBOL or HCO for DB2 LUW in Enterprise Developer and the DB2 software is not
installed on the client machine where you are using the Eclipse IDE, you receive
background parsing errors in your application. To resolve the issue, you can do either
one of the following:

• Disable background parsing Window > Preferences > Micro Focus > COBOL >
Editor and disabling the checkbox for Background parsing.
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• Install the IBM DB2 client-side software on the machine on which you are running
Eclipse. Go to the IBM Support Home and locate the page entitled "IBM Download
Fix Packs for IBM Data Server Client Packages" .

Eclipse IDE If you are upgrading your license from Enterprise Developer Personal Edition (v2.2 or
earlier) to Enterprise Developer, or from Enterprise Developer Connect (v2.2.1 or
later) to Enterprise Developer, any existing projects compiled to either .exe or .dll files
using the old license must be updated in order to recreate the .cobolBuild file. You
can do this done by adding or removing files from the project or by deleting
the .cobolBuild file. Updating the project in this way ensures the IDE will fully build
the executable files.

Enterprise
Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation • Before installing this release as an upgrade to an existing installation of the
previous version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is
to avoid some problems that might result in files not being installed. This is
required only on Windows.

• Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server
Administration home page, click Export and then select Export Enterprise Server
configuration and Security Manager definitions. This creates a backup folder in
the c:\programdata\micro focus\Enterprise Developer\MFDS. You
can restore the Enterprise Server configuration after installing this release - click
Import on the Enterprise Server Administration home page.

• On UNIX, check UNIX Installer Issues before you start the installation.

JCL VSE When running Enterprise Server applications on HP Itanium in 32-bit mode, if you
receive an error such as "CASCD1057S JES Initiator for Server ... abended by signal
00004", you need to set the environment value COBMAINSTACK to a value greater
than 500000 to increase the default stack size.

Micro Focus
Rumba

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4
loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a
TN3270 emulator such as Micro Focus Rumba may fail. To work around this issue, in
your emulator's configuration use 127.0.0.1 in preference to localhost or your host
machine's name.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic
may fail with a ClassCastException. To work around this issue, you need to deploy
mfcobol-xa.rar first, then need to undeploy this file and deploy the local one,
mfcobol-localtx.rar. If there are issues deploying using the WebLogic GUI, you
can use the command line. If there are issues with this as well, try reducing the length
of the command (for example, by moving the file to a location with a shorter path).

Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
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The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• MTO - JCL ESMAC
• MTO - JCL MVS
• MTO - JCL System Catalog
• MTO - JCL Utils - IDCAMS
• Open PL/I Compiler
• Open PL/I Debugger
• Open PL/I RTS
• SQL: COBSQL

MTO - JCL ESMAC

Back to the list

• As part of an enhancement to improve performance of the spool display function, several new indices
have been added to the casspool.dat file. If you are upgrading from a previous release, you must
convert the casspool.dat file of any enterprise server created before Enterprise Developer 2.2
Update 1 to the new format before starting any JES-enabled enterprise server and submitting jobs to it.

This release provides the following scripts that convert the casspool.dat file to the new format:

• On Windows: fixcasspool.bat in %COBDIR%\bin or %COBDIR%\bin64
• On UNIX/Linux: fixcasspool.sh in $COBDIR\bin

,

To convert the casspool.dat file, run the appropriate script from an Enterprise command prompt
using the following syntax:

• On Windows:

fixcasspool.bat <old-location>casspool.dat <new-location><backup_filename>

• On UNIX/Linux:

fixcasspool.sh <old-location>casspool.dat <new-location><backup_filename>

Where:

• <old-location> - the fully or partially qualified location of the existing casspool.dat file, if not in the
current directory. Optional.

• casspool.dat - the spool file that will be updated. The file is located in the same directory as the
enterprise server's system catalog.

• new-location - the fully or partially qualified location where the backup file will be created, if not in the
current directory. Optional.

• backup_filename - the name of the file that will be a back-up of the old casspool.dat file. If the file
name already exists, the script terminates without converting the casspool.dat file.

If you do not convert casspool.dat, attempts to start the enterprise server fail with the following
messages:

JES000011E Batch Spool File Error; Status [39]  
          JES000130E Note JES000011 Error - New casspool indexes may need 
generating. See error 
          description in product docs  
      

2654417 (1090421)

MTO - JCL MVS

Back to the list
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• The final disposition processing of temporary datasets has been corrected to be in line with the
mainframe processing, with a default value of PASS unless DELETE has been specified in the DD card.
Previously, the default value was DELETE.

2671175 (1091627)
• When running batch programs, receiving an "Out of Space" error requires operator intervention to

continue processing.

2642115 (1089055)

MTO - JCL System Catalog

Back to the list

• You can now use MGMTCLAS to provide an EXPIRE AFTER number of days. This is used to calculate
an expiry date for datasets allocated using the MGMTCLAS parameter.

2664639 (1090992)
• MFLEX*.DAT files were not being moved with spool files. Spool housekeeping now deletes LEX files

when it deletes JESYSMSG. Also, to identify any remaining orphan LEX files, the
MF_SPOOL_HK_LEX_SCAN environment variable sets spool housekeeping to scan the data directory
for LEX files older than the max retain period.

2659555 (1090759)
• Spool housekeeping has been rewritten to provide a number of new features. These will be described in

the product documentation.

(592452)

MTO - JCL Utils - IDCAMS

Back to the list

• The state of VSAM virgin files is now being correctly processed.

2686149 (1093587)
• A REPRO COUNT of zero is now processed as zero records to be included in the REPRO operation.

2665006 (1091034)

Open PL/I Compiler

Back to the list

• On Intel platforms, the -bitsltr Compiler option can be used to store bit strings left-to-right within each
byte. This is similar to Big Endian bit ordering on Intel platforms. The Intel default is to store bit strings
right-to-left within each byte similar to the Intel hardware bit ordering.

2675860 (1092098)
• The libraries libmf.so, libespli.so and libespliz.so are no longer delivered. This is

transparent if linking PL/I objects using mfplx or ldpli, and no changes are needed to your build process.

However, if linking PL/I objects using either the UNIX ld command or the Enterprise Developer cob
command, you must include the libraries libmfpli.so when linking stand-alone Open PL/I objects
(executed outside of Enterprise Server), or libmfpliz.so when linking PL/I objects executed under
the control of Enterprise Server.

To do this, use the option -lmfpli for stand-alone Open PL/I objects or -lmfpliz, respectively, for PL/I
executed under Enterprise Server. These options replace the –lmf option.

• Open PL/I applications must be recompiled and re-linked in order to use them with this release.
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Open PL/I Debugger

Back to the list

• The debugger now stops before an ON UNIT triggers. This lets you perform debugging on the ON UNIT
itself. You can configure the ON UNITS the debugger stops on.

2674783 (1092319)

Open PL/I RTS

Back to the list

• Writing to SYSPRINT when running outside of Enterprise Server now drives output directly to the
terminal and does not buffer the I/O.

2477031 (1076203)

SQL: COBSQL

Back to the list

• COBSQL now displays appropriate COBOL syntax errors after encountering EXEC SQL statement
errors.

2673619 (1093197)

Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Compiler: HLL Macro Assembler
• Assembler Program Execution
• CAS (COBOL App Server) General
• CAS Admin Console
• CAS Resource Manager Interface
• CAS Security
• CAS XA Switch modules
• CASRDO
• Compiler
• Compiler ECM Support
• CICS BMS Screen Painter
• Cobdebug
• Documentation
• Eclipse - Debug
• Eclipse IDE
• Eclipse IMTK
• ES Monitor/Control (ESMAC)
• File Handling - External File Handler
• File Handling - Fileshare
• File Handling - Sort / JCL Sort
• HCO for Microsoft SQL Server
• Interface Mapping Toolkit General
• JVM - Compiler
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• JVM - RTS
• LE370 Support
• MDSA API for CAS
• MF Communications Server
• MF Directory Server
• MF Server Administrator (GUI)
• MFA: GUI components
• MFA: Mainframe
• MFIO
• Micro Focus Heartbleed Update
• MTO - CICS BMS Screen painter
• MTO - CICS Communications
• MTO - CICS ECM/Preprocessor/Translator
• MTO - CICS Emulation
• MTO - CICS ESMAC
• MTO - IMS DB
• MTO - IMS MFS
• MTO - IMS Other
• MTO - IMS TM
• MTO - JCL ESMAC
• MTO - JCL MVS
• MTO - JCL System Catalog
• MTO - JCL TSO
• MTO - JCL Utils
• MTO - JCL Utils - IDCAMS
• NCG
• Open PL/I CICS Preprocessor
• Open PL/I Compiler
• Open PL/I Macro Preprocessor
• Open PL/I RTS
• Open PL/I SQL Preprocessor
• RJSE - JCL
• Run-Time System
• Setup Issues (UNIX)
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: HCO for SQL Server
• SQL: OpenESQL
• UNIX Cob
• Web Service Client
• XDB Server
• XDB: Problems not classed above
• XML Syntax Support Preprocessor
• XML Syntax Support Runtime

Adis

Back to the list

• REVERSE-VIDEO now works as expected when using the X"AF" function.

2683509 (1092851)
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• MS ACCEPT statements now sound a beep when invalid characters are entered into integer or decimal
fields. Integer fields no longer accept invalid characters and normalise.

2680081 (1092542)
• MS ACCEPT statements now display numerics with space fill and sign leading so that integers and

decimals are appropriately aligned.

2680081 (1092543)
• The attributes specified in the screen section are now displayed correctly after a call to the X"AF"

function 81 has been made.

2650012 (1089634)

Assembler Compiler: HLL Macro Assembler

Back to the list

• The /PREPASM operand used with the BMS generator utility to invoke the MFASM Assembler to
expand copyfiles (MFBMSCL <bms_filename> /PREPASM) was affected by a long and spacey filename
fix to the MFASM command line handler that resulted in the Assembler macro processor not running.
The issue with the command line has now been fixed and COPY statements in BMS modules are now
expanded correctly.

2685507 (1093084)

Assembler Program Execution

Back to the list

• Previously, if you assembled and linked an Assembler module with the ANIM option turned on and then
you ran it under Enterprise Developer 2.1, and the ES_CONSOLE_SERVER environment variable was
not set to YES, an error 197 would occur as the Assembler run-time system attempted to bring up the
Assembler debugger and make screen displays from it. Now, if ES_CONSOLE_SERVER is not set, the
Assembler run-time turns the debugging flag off and just zooms through the module without invoking
the Assembler debugger. Additionally, ES_CONSOLE_SERVER now accepts both YES or Y as values
and they can be either upper or lower case.

(596477)

CAS (COBOL App Server) General

Back to the list

• Multiple casout calls (using the -r option) in a single process now work correctly.

2694290 (1093800)
• When accessing TS/TD on error, the file status is now displayed correctly.

2684719 (1093023)
• HSF records no longer contain incorrect dates when a task runs past midnight at the end of a month.

2644616 (1089363)
• Messages issued from casstop are now sent to stdout.

2643162 (1089019)
• All system abend messages are now reported to the console.

(602933)

CAS Admin Console

Back to the list
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• The JES Program Path and CICS Transaction Path now accept paths of up to 4096 characters.

2665324 (1091104)

CAS Resource Manager Interface

Back to the list

• A thread synchronisation issue was causing responses to be lost intermittently. For stateful requests,
this could result in lost SEPs (whereby a SEP would appear as busy even though it was not processing
any work).

2686429 (1093442)

CAS Security

Back to the list

• A new user objectclass instance added to an LDAP-based external security manager now has its initial
login attempts count value set correctly.

2637659 (1088656)

CAS XA Switch modules

Back to the list

• The Declared Global Temp table is being dropped at CICS end of task with XDB as resource manager.

2682648 (1093069)
• A new SQL Server XA switch module provides support for xa_recover and also handles implicit rollback

by SQL Server more cleanly than previous switch modules.

2679162 (1092481)

CASRDO

Back to the list

• Clicking Resources > JES > Catalog in ESMAC now opens the initial screen without showing the
results of any previous searches.

2656391 (1090454)

Compiler

Back to the list

• LOCAL-STORAGE data in nested programs now behaves as expected and as it does on the mainframe
- as LOCAL-STORAGE of the main program.

2693843 (1093746)
• A MOVE from a group item to a DBCS target that requires padding now behaves as expected.

2692634 (1093553)
• DELETE statements that contain the END-DELETE scope terminator now compile as expected.

2690465 (1093235)
• UNSTRING on LINKAGE SECTION data items with reference modification could sometimes give the

wrong result.

2684812 (1092998)
• Using large EXEC SQL statements no longer causes the Compiler to hang.

2684713 (1092993)
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• The ? NUMERO SIGN (U+2116) Shift-Jis FA59/8782 is now converted correctly to EBCDIC value 446e
under CHARSET(EBCDIC).

2683297 (1092823)
• MOVE figurative constant to PIC G item under CHARSET(EBCDIC) now returns the expected results.

2683091 (1092801)
• A MOVE CORRESPONDING statement with a GLOBAL subscripted target now compiles as expected.

2682557 (1092981)
• A program compiled with the FDCLEAR Compiler directive and containing a numeric file record now

compiles as expected.

2678050 (1092326)
• The asterisk character is now treated correctly in COPY REPLACING text under mainframe emulation.

2676006 (1092571)
• A literal greater than 80 bytes but less than 160 bytes in length and containing non-ASCII characters will

now compile as expected with a mainframe dialect.

2670083 (1091560)
• Programs that contain EXEC INCLUDE statements inserted by a preprocessor now debug as expected.

2661838 (1091416)
• ISO2002 and SNI table VALUE syntax is now working as expected for multi-dimensional tables that are

not directly nested within each other.

2651916 (1089808)
• The Compiler error message 62 (COBCH0062) has been clarified by changing "Nested COPY

replacement not supported" to "Nested COPY replacement causes termination of parent COPY
replacement".

(599823)
• The SQL TYPE DBCLOB(n) now creates the correct COBOL record structure.

(599679)

Compiler ECM Support

Back to the list

• The SQL(CHECK) option no longer incorrectly affects the setting of the unrelated NCG option 'CHECK'.

2685791 (1093351)

CICS BMS Screen Painter

Back to the list

• The BMS compiler no longer generates a MOD or copy file if errors or severe errors are encountered
during compilation. To revert to the previous behavior, where the BMS compiler generates a MOD or
copy file even if it encounters errors or severe errors, specify the /IE directive.

(595227)

Cobdebug

Back to the list

• When stepping through a program that has a watchpoint set in it, all statements are now being stepped
correctly.

2664045 (1091500)
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Documentation

Back to the list

• You may now specify an SSL-enabled listener when submitting jobs via CASSUB. You achieve this by
using the tcpssl protocol on the /s or -s switch.

2671020 (1091619)
• When creating a VSAM data set using the DEFINE CLUSTER command, records are assumed to be

variable-length, unless the NUMBERED parameter is used and the RECORDSIZE parameter specifies
the same length for the average and maximum record size, in which case, fixed-length is assumed.

2615989 (1088176)
• The Important note about User Access Controls in the IMTK Tutorial now clarifies that this applies to

Windows users only.
• A compiler directive INIT-BY-TYPE has been provided to allow initialization of each data type to a

sensible value for that type.

2650462 (1091658)
• The INITIALIZE verb now supports multiple categories in a single REPLACING clause.
• Variable length record files that are 4 bytes or smaller are padded to 8 bytes.

2537147 (1081777)
• The installation instructions now list the required libraries for IBM System z (390) in the Software

Requirements section of the installation instructions of the product help.

2683015 (1092919)

Eclipse - Debug

Back to the list

• The Enterprise Server Dynamic Debugging facility, cobesdebug, is now supplied with this product to
enable character mode debugging of transactions and services running on a local enterprise server on
UNIX and Linux. See your product documentation for information about how to use the facility.

2685218 (1093046)
• Stepping through a program with copybook files that contain a single line now highlights the COPY

statement correctly.

2674776 (1092000)

Eclipse IDE

Back to the list

• When creating NFS or RSE remote projects, you can now use a new type of remote connection, Micro
Focus DevHub using SSH. It uses the standard SSH daemon and a UNIX command to launch the
DevHub server and does not require the DevHub daemon to be running.

2681305 (1092717)
• When there is a breakpoint set on a copybook in Copy View, during debugging the execution only stops

once for this instance of the copybook.

2675063 (1092946)
• Build projects that contain a large amount of folders no longer causes the IDE to freeze.

2674982 (1092179)
• It is now possible to debug Windows services using the Eclipse IDE. You must use a command prompt

of the computer running the service.

2674623 (1092008)
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• When debugging Enterprise Server applications that use remote projects, you can now add remote file
system directories to the Debug Symbols lookup path.

2653012 (1092794)
• When debugging a program running on a remote machine, you could receive errors if stepping quickly

through the program.

2651982 (1090920)
• Eclipse no longer crashes when importing new programs into a COBOL project or when using the

"Determine Directives" menu item.
• An issue with importing Net Express projects that built ocx targets has been resolved.
• In COBOL Explorer, you can now use two new file context menu commands to indicate that a COBOL

program is a copybook (Transform Program to Copybook) and that a copybook is a COBOL program
(Transform Copybook to Program). You may need to use these in situations when you imported existing
COBOL source code in the Eclipse IDE and some of the files were incorrectly identified as either a
copybook or a COBOL program.

• A problem that prevented locating resource files within linked resource directories has been resolved.
• The underlying version of Remote System Explorer has been updated from 3.3 to 3.5 to resolve issues

with Japanese locales and messages in remote projects.
• If the debugger steps on a line with an unassigned linkage item (for example, if you are debugging only

a part of your application and no memory has been allocated to that linkage item), debugging
terminates. To assign linkage to that data item and continue debugging, right-click the data item, and
click Inspect COBOL. When prompted, confirm and assign a value to the data item. Alternatively, to
assign linkage, you can right-click the data item in the Variables view and select "Change Value".

• Opening revisions of a COBOL file from a Source Control System plugin in Eclipse is now supported for
CVS, SVN or other SCM plugins. It is now possible to open revisions of COBOL files from the COBOL
search view, the CSI search view, the Find Reverence view. Navigation between the Outline view and
the editor and using the "Locate definition" (F3) command is also supported.

• The Generate Client from WSDL feature is now documented.

Eclipse IMTK

Back to the list

• You can now use the Interface Mapping Toolkit to create Web Services and Java Interfaces for remote
COBOL projects.

ES Monitor/Control (ESMAC)

Back to the list

• In the ESMAC (casrdo45) page, there is now provision to filter and list the members of a particular PDS.
The filter text is PDSNAME(*). The PDSNAME should be the complete name of the PDS, and cannot
contain any wildcards.

2500753 (1078391)

File Handling - External File Handler

Back to the list

• Under Mainframe emulation, when an empty virgin VSAM file is opened for input or for input/output, a
file status of 35 is returned, regardless of the access mode specified.

2692826 (1093604)
• When using the RMFM File Handler, a file status '05' is returned when executing a DELETE FILE

statement, if appropriate. This emulates the behavior of the RM/COBOL run-time.

2685220 (1093089)
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• A rollback recovery of a REWRITE where the record size was being reduced was producing incorrect
results.

2685069 (1093085)
• When a DD name is associated with several concatenated data sets of different charsets, the returned

data has the charset encoding of the first data set. However, if the first data set is LSEQ, the returned
data has the charset encoding of the application program.

2677941 (1092434)
• cobfhrepro2 now produces the correct output for FCD2.

2664465 (1090972)
• A new environment variable, STRICTVSAM, has been introduced. When it is set to ON and under a

mainframe emulation, a file status of 37 is returned when you open an existing VSAM file for OUTPUT
and the file has or previously had some data written to it, or if the file format is different from the file on
disk. The default for this variable is OFF.

2660766 (1090639)
• When reading concatenated datasets, each dataset in concatenation must use the same RECFM,

either all FB or all VB.

2654517 (1091793)
• The FOLDER section in a file handler configuration file now supports relative paths.

2653787 (1090290)
• Btrieve files are now supported, using the xfh2btr call conversion module, for native COBOL, running in

a Windows environment.

2598434 (1086466)
• 64-bit fileshare clients would fail to connect if any cci configurations settings were used.

File Handling - Fileshare

Back to the list

• The Escape character was not being honoured for filenames passed to FSVIEW which caused
filenames containing $ to be interpreted as environment variables.

2660207 (1093021)
• MFJSORT now correctly displays the file status of a queried VSAM file, rather than a generic error

message, when the file being queried returns a non-zero file status.

2589273 (1092107)

File Handling - Sort / JCL Sort

Back to the list

• When VLFILL is specified in OUTFIL, the variable length records smaller than the LRECL/OUTREC are
now correctly padded with the value specified in VLFILL rather than with spaces.

2680553 (1092622)
• Under ICETOOL emulation, the maximum size of an ON Field for PD data type has been increased

from 8 to 31 bytes in order to emulate mainframe behavior.

2680285 (1092551)
• The PARM options CORE, SIZE and MSG are now parsed and ignored.

2675829 (1092090)
• After a SORT operation, the memory allocated by SORTTEMPSPACE is correctly freed.

2666797 (1091311)
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• MFSORT now correctly sorts NU fields when SORT-EBCDIC is specified.

2663772 (1090910)

HCO for Microsoft SQL Server

Back to the list

• The NOSTMTCACHE SQL compiler directive option is invalid and no longer available when setting SQL
Preprocessor options from the IDE.

2694876 (1093861)
• OpenESQL returned an error when a FETCH had more output host variables than the number of

available result columns; OpenESQL now ignores excess columns, resulting in improved compatibility
with DB2.

2694548 (1093840)
• Previously, a problem occurred with DB2 YEAR() function when taking date duration or timestamp

duration as argument with the directive SQL(DIALECT=MAINFRAME).

2683713 (1092874)
• Using FETCH OR SELECT INTO statements that have more output host variables than the number of

columns in the result no longer results in errors.

2676276 (1092708)
• The SPD generator did not honor the EXTERNAL NAME option correctly during the generation of the

stored procedure wrapper.

2659338 (1090674)
• HCOSS now emulates mainframe SET CURRENT SQLID and SET CURRENT SCHEMA statements.

2507765 (1078735)

Interface Mapping Toolkit General

Back to the list

• RESP condition code information is now available to COMMAREA Web Service clients when EXEC
CICS LINK errors occur.

2671956 (1093056)
• The Driver Program name of a COMMAREA Service Interface cannot be the same as an operation's

program name. Service Interface Validation now performs a check for this.

2669112 (1091799)

JVM - Compiler

Back to the list

• The statement ACCEPT operand FROM DATE-ISO4 now works correctly in .NET and JVM COBOL.

2681556 (1092861)
• When compiling for JVM COBOL, COMPUTE statements within a large perform range, where the

arithmetic expression involves division by a power of 10 now produces the expected results.

2680641 (1092792)
• A new Compiler directive has been introduced to control how a method that has an array as its last

parameter can be called. When ILPARAMS is set (which is the default), you can call the method using a
list of items of the same array element type, instead of specifying a single array. When ILPARAMS is not
set, you can only specify a list of items if the target method has the PARAMS attribute. Previous
compiler versions allowed the use of a list even when the method did not have the PARAMS attribute,
which is equivalent to the current default behavior.
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JVM - RTS

Back to the list

• Fixed an error in arithmetic statements in JVM COBOL where the target is a comp-2 item.

2691797 (1093424)

LE370 Support

Back to the list

• LE370 parameters that continue on the next line are no longer flagged.

2681691 (1092669)
• TSO ALLOCATE command emulation now supports the use of "F B".

2668742 (1091453)
• An unsupported LE option in the code no longer invalidates the options that follow.

2668740 (1091425)
• A fault that caused the data received by an EBCDIC program when a 'READ from SYSIN' was

performed to be in ASCII format has been corrected.

2657391 (1090401)
• CEE3PRM now successfully retrieves the parm value to the calling program.

2654879 (1090140)

MDSA API for CAS

Back to the list

• If an enterprise server instance is started by an Enterprise Server user account that has execute
privilege but not update privilege for that server, you now receive an INSUFFICIENT_ACCESS error
when the server starts.

2664445 (1091238)

MF Communications Server

Back to the list

• When using casout to get job information, sometimes you could receive an error and the output was
trucated.

2693283 (1093638)
• An issue where terminating 3270 sessions would result in high CPU usage in the MFCS process has

been fixed.

2682179 (1092886)
• The mfpackage utility for removing deployed services from Enterprise Server is now included with Micro

Focus Enterprise Developer UNIX Components.

2675212 (1092127)
• In version 2.2 of this product, the received data was missing from the trace messages for CTG and ISC

conversations. This has now been fixed.

2674286 (1091971)
• Some of the Enterprise Server functions for informing running enterprise server of security updates and

for retrieving the list of printers available on the server system were broken in Enterprise Developer 2.2.
This has now been fixed.

(601260)
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• You no longer receive exceptions in MFCS when the data-trace option is enabled for a CTG listener.

(601465)

MF Directory Server

Back to the list

• When using the export and import functionality of the MFDS XML Enterprise Server configuration, XRM
name and label definitions are now exported and imported correctly.

2683510 (1092852)
• When using the export and import functionality of the MFDS XML Enterprise Server configuration, the

open and close string properties of XRM resources now support the inclusion of double quotes.

2682635 (1092777)
• On Solaris SPARC, the value of the Enterprise Server Administration GUI journal size option was being

incorrectly set to zero.

2681195 (1092638)
• When adding or editing an IMS MPR definition in the Enterprise Server Administration GUI, you can

now use comma as a separator in the class field to enter multiple class definitions.

2676449 (1092164)
• The mfds export and import command line options -x and -g XML now also support exporting and

importing enterprise server script configuration information.

2668554 (1091412)
• XML import in the MFDS no longer fails if the XML source code contains long paths.

2668553 (1091409)
• When using the Enterprise Server Administration to edit the properties of JES Initiators, JES Printers,

IMS MPRs and XRMs, the GUI now rejects duplicate names.

2668020 (1091336)
• Session cookies in the browsers for the Enterprise Server Administration GUI now use the HttpOnly flag

for additional security.

2666975 (1091258)
• The browser auto-complete feature is now disabled for the password fields in the Enterprise Server

Administration GUI.

2666975 (1091260)
• If the Enterprise Server Administration HTML GUI is in "restricted access" state, a logged on user now

needs to have "administer user" levels permission to see the "Display" options in the LHS of the GUI.
This includes the "Directories", "Statistics", "Sessions" and "Journal" menu options. The "administer
user" option is available by default to any member of the #DSAdmin MFDS user group. In MLDAP ESM
security, this permission is defined by Update, Add or Delete ACE permissions against the "User
Administration" resource in the "Enterprise Server Administration" resource class under "Enterprise
Server Resources".

2663991 (1090934)
• When exporting the Enterprise Server configuration in XML format with the "mfds -x" command line

option, the MSS ISC and CTG listener information was not formatted correctly, which resulted in an
incorrect behavior when you reimported the XML configuration.

2651735 (1090147)
• When you use the Enterprise Server Administration HTML GUI to create a user group, the following

characters are no longer allowed in name: '< >', ';', '"' and '&'.

MF Server Administrator (GUI)

Back to the list
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• When trying to change a password from the Enterprise Server Administration HTML logon page,
additional checks are made before reporting the success or failure of the request.

2659582 (1090525)
• The execution scripts configured for an enterprise server instance can now use the credentials specified

on the Start\Stop page of the server in Enterprise Server Administration. For example, to use the
specified credentials to start an enterprise server instance, you need a script with the following
command:

• On Windows:

casstart /r%ES_SERVER% /u%TXUOPERATOR% /p%TXPOPERATOR%

• On UNIX:

$ES_SERVER, $TXUOPERATOR

Where:

• TXUOPERATOR resolves to the user id.
• TXPOPERATOR resolves to the password.

After the enterprise server instance uses these environment variables, they are reset to blank and are
no longer available to query.

2599100 (1086661)

MFA: GUI components

Back to the list

• Missing SI characters no longer cause an abend. Incorrect DBCS character streams are now ignored.

2667289 (1091404)
• After the MFA server sends a 9/218 error ("Unsupported DCB/DSORG"), the data set is released and

can then be reallocated.
• If an x37 out of space abend occurs when running an MFDAS EXPORT command, the affected data set

is deallocated and available for use.

MFA: Mainframe

Back to the list

• The MFA server now works with CA Endevor R16.0. You will need to update your MFA and MFAE JCL
in order to use the new libraries.

2692338 (1093691)

MFIO

Back to the list

• MFGENER now works with the server using FCD3 protocol.

2676130 (1092134)
• The comments in the MFAVTAM sample member have been updated.

2674286 (1091976)
• SM2 no longer segfaults when a member has been deleted on the mainframe.

Micro Focus Heartbleed Update

Back to the list

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.
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MTO - CICS BMS Screen painter

Back to the list

• BMS COPY files will be found in the /SYSLIB folder when the /PREPASM directive is used to include
the COPY files.

2685507 (1093277)
• The message "BMSCH1101S COPY file expansion requires directive /PREPASM" is no longer

displayed if copy file expansion fails due to errors in the copy file.

2669082 (1091499)
• The BMS Compiler no longer fails with an access violation error when invoking a user pre-processor (/

PCOMP=...).

2669050 (1091679)
• The BMS Compiler no longer fails if the /MAP name exceeds seven characters. A message is displayed

and the name is truncated to seven characters.

MTO - CICS Communications

Back to the list

• When converting a transaction typed on a DBCS terminal from EBCDIC to ASCII, the conversion did
not use the length of the transaction but the length of the variable that was holding it. This has been
fixed and the conversion now uses the length of the transaction.

2676259 (1092144)

MTO - CICS ECM/Preprocessor/Translator

Back to the list

• DFHRESP(TIMEDOUT) was missing from the CICS precompiler tables. The value has now been
added.

2675857 (1092238)

MTO - CICS Emulation

Back to the list

• In CICS transaction routing, BMS Maps in DBCS environment are now displayed correctly.

2680118 (1092510)
• When importing a startup list that had more than one group in it, only the first group was imported. This

has been fixed.

2659018 (1090500)
• When the casprt process dies, it will now be restarted automatically.

2593342 (1086058)

MTO - CICS ESMAC

Back to the list

• The ESMAC page now displays CICS TERM definitions correctly.

2676448 (1092163)

MTO - IMS DB

Back to the list
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• An IMS application written in PL/I could produce an unexpected error RTS114 in MFIMSEP.

2680509 (1092550)
• A non-zero return code from an IMS application program written in PL/I now sets JES COND CODE.

2680115 (1092509)
• IMS Data Capture exit routines were not called for the destination parent segment during update of a

concatenated segment in a logical DB when the logical child segment did not have an exit defined.

2676941 (1092370)
• You could receive an error RTS 114 in MFIMSDBS if a BMP was killed after issuing a large number of

uncommitted database updates.

2671177 (1092024)
• Previously, Roll Forward recovery was incorrectly asking whether to recover the same file multiple times.

MTO - IMS MFS

Back to the list

• Screen data in a conversational transaction is no longer misaligned when the first field after the
transaction code contains spaces.

2680867 (1092593)

MTO - IMS Other

Back to the list

• The message "OPEN ERROR ON MESSAGES FILE, STATUS=35 DSN=IMSWND.MSG" was
sometimes issued in place of an IMS error message, depending on the preceding program execution in
a JES initiator.

2665550 (1091186)

MTO - IMS TM

Back to the list

• IMS-TM no longer becomes unresponsive upon multiple application ABENDs.

2664063 (1091514)

MTO - JCL ESMAC

Back to the list

• When browsing the catalog via ESMAC, the maximum number of lines displayed is controlled by the
environment variable ES_MAX_CATALOG_LINES, which has a default value of 5000. This is introduced
for stability and performance reasons. If you wish to display more than 5000 lines, you need to set the
environment variable to a higher value in Configuration Information on the General tab in MFDS. See
"Setting Environment Variables for Micro Focus Directory Server" in the online documentation for more
information.

2671855 (1091696)

MTO - JCL MVS

Back to the list

• A new environment variable, JES_PRINT_SPOOL_MSG=[CONSOLE|LOG|SILENT], can be used to
control the disposition of the spool dataset printing message (JES000029I). Environment values are:
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• CONSOLE - send the message to the console (default).
• LOG - write the message to a special log file named PRNT_SPL_MSG_YYYY_MM_DD.DAT where

YYYY_MM_DD is the current date. This file resides in the same directory as casspool.dat, and a
new file is created every day.

• SILENT - no message. Use this option with caution, as you will have no audit log of your spool
datasets.

Note: This environment variable is introduced for high print load users, where print messages to
the console impact system performance.

2660637 (1091746)

MTO - JCL System Catalog

Back to the list

• In the MVSCATPB API, the second and any subsequent reads of catalog records for dynamic PDS
were not returning the extension lisy.

2685834 (1093098)
• New empty dynamic pds members are now retained if they have been opened for output, to extend, or

for an update.

2681745 (1092834)
• Deleting the JESYSMSG from ESMAC (casrdo43) now deletes all the associated files.

2659558 (1090837)
• The last change date on the catalog entry for a dynamic PDS model is set to the current date when a

new member is added to the PDS.

2581611 (1091084)

MTO - JCL TSO

Back to the list

• An issue related to temporary datasets later referred to as permanent ones has been corrected.

2676531 (1092360)
• A problem when running batch programs with large parameters has been fixed. A parameter with length

of up to 100 characters can now be passed to the user program.

2671469 (1091663)
• Previously, after a batch job using IKJEFT01, a SEP was incorrectly terminating with CASKC0026E

Error unloading service '' after IKJEFT step with DSN.

MTO - JCL Utils

Back to the list

• Setting MFALLOC_PCFILE=Y would not create the file if RECM=LSEQ.

2682866 (1092920)
• Using MFGENER to copy RECFM=VB to RECFM=FB no longer results in bad data in the output file.

2679429 (1092796)
• When copying an LSEQ dataset to a dataset with no dsorg specified, IEBGENER did not correctly

assign the default dataset characteristics.

2663396 (1090889)
• There is now an extra validation for IEBGENER to check that the attributes of concatenated SYSUT1

files are compatible.

2654517 (1090132)
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• When a job deletes a G0000V00 dataset belonging to a GDG, the DG manager updates its internal
BIAS/G00000V00 table to reflect it, so that subsequent references to the GDG via relative BIASes
within the same job are resolved the same way as on the mainframe.

2650338 (1089941)

MTO - JCL Utils - IDCAMS

Back to the list

• An existing SYSIN of type Dynamisc PDSM no longer causes a failure.

2686421 (1093226)
• It is now possible to use wildcards to specify the names of PDS members to delete.

2684823 (1093005)

NCG

Back to the list

• An error could occur at generate time for programs with calls to INTRINSIC functions that had multiple
ALL subscript parameters.

2695026 (1093885)
• An issue in cob which caused a core dump when all entry points in the main program were invalid has

been fixed.

2663974 (1090927)
• An issue has been resolved where the debugger would not step into the code when a PERFORM

statement is the last statement in a WHEN branch of an EVALUATE statement.

Open PL/I CICS Preprocessor

Back to the list

• Passing the CICS Preprocessor option -optcics with exci=y results in the correct preprocessing to
enable batch operation with CICS connect if separate commands rather than mfplx are used to process
the program. For example, to correctly preprocess and enable batch operation with CICS connect for
the program pliexcit.pli, you would enter these separate commands:

mfpp -margins 2,72 pliexcit.pli -pp pliexcit.pp 
          mfexecpp -cics -optcics exci=y pliexcit.pp -ppcics pliexcit.ppc 
          mfpp pliexcit.ppc -pp pliexcit.pp2 
          mfpli -mvs pliexcit.pp2 -o pliexcit.obj 
          ldpli -mvs -dll pliexcit.obj

2675232 (1092033)
• A semi colon is no longer emitted within the comment with the -full_list macro preprocessor option

specified. Also, when using %INCLUDE, the generated comment line for multiple files included with a
single statement no longer erroneously contains the name of the file which included them.

2676504 (1092187)
• COMMAREA no longer incorrectly passes to linked-to programs.

2667530 (1091299)

Open PL/I Compiler

Back to the list

• Using the concatenate operator with character varying strings now works correctly when compiled with -
opt.

2692333 (1093522)
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• A problem with a CHAR(1) repetition factor of 32765 causing the Compiler to loop indefinitely has been
fixed.

2684548 (1092979)
• Procedures returning picture numeric data now work correctly when compiled with the -opt compiler

option set to 3.

2681995 (1092728)
• A possible compiler abort when using the -map option no longer occurs.

2680528 (1092553)
• A problem that caused a compiler abort with ONCODE 90011 no longer occurs.

2679977 (1092500)
• A problem causing the XMLCHAR built-in to not work correctly no longer occurs.

2678830 (1092398)
• A problem causing the XMLCHAR built-in to not work correctly no longer occurs.

2678830 (1092399)
• Internal: The undocumented option -newalign was provided to Luigi B. et al for this functionality

specifically for NCG.

2675416 (1092054)
• A problem with Static structure assignments causing Error MFPLI01233E no longer occurs.

2675201 (1092023)
• A problem with binary integer constants in certain built-ins no longer occurs.

2675077 (1092015)
• A problem causing a Compiler Abort ERROR 2000A no longer occurs.

2673693 (1091875)
• Converting FIXED DEC to BIT no longer produces the wrong number of bits.

2673494 (1091883)
• The ODBC pre-compiler no longer incorrectly passes a long SQL statement to pre-compiler services

resulting in an MFPLI01250S error.

2673288 (1091838)
• A problem with large string concatenation producing blanks and data loss during Restricted Expression

Evaluation no longer occurs.

2673288 (1092450)
• Unnamed structure members no longer cause compiler errors.

2673130 (1091820)
• When a BYVALUE parameter is greater than 4 bytes, such as a non-ideal argument that is not a true

immediate, the argument is now passed as -if enclosed by parentheses instead of generating a severe
error.

2667144 (1091256)
• A problem no longer occurs when passing a named constant of type pointer as an argument to a

subroutine.

2665622 (1091101)
• A program that previously triggered a SIGSEGV when compiling with the Open PL/I Compiler no longer

does so.

2645146 (1089173)
• The PL/I compiler now supports the REPATTERN built-in function.

2467971 (1075524)
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Open PL/I Macro Preprocessor

Back to the list

• The macro preprocessor no longer generates extraneous additional linefeed characters when using -
margins with a %REPLACE statement where the new text exceeds the length of the original
%REPLACE constant text.

2692525 (1093557)
• The Open PL/I Macro Preprocessor no longer incorrectly handles the IBM deviation of the %INCLUDE

which used the format: %INCLUDE PDS(MEMBER); The Macro Preprocessor now parses for
"MEMBER" and uses the -isuffix and -ipath options to locate the %INCLUDE file.

2691090 (1093340)
• The macro preprocessor no longer goes into an infinite loop when incorrectly coding a macro

preprocessor function with missing parameters and punctuation.

2682716 (1092764)
• A %XINCLUDE is no longer skipped due when a prior %XINCLUDE is conditionally excluded.

2682455 (1092750)
• When a PL/I Macro uses the STATEMENT option of the PROCEDURE statement and is invoked within

the input source using the keyword format without a trailing semi-colon, the macro preprocessor no
longer goes into an infinite loop.

2681527 (1092655)
• When a macro generates a single line of returned CHAR data containing multiple logical lines and no

carriage returns, the returned data no longer wraps at or near 256 bytes if using the -margins option.
when using the -margins option, the macro preprocessor will now use the right margin as the point
where wrap is attempted. This results in the customer macro producing a comment that is formatted
similar to the mainframe format, providing an improvement over previous functionality.

2679415 (1092449)
• The macro preprocessor no longer fails processing or flags a macro as having incorrect function

parameters if an unquoted period (.) is passsed to a macro preprocessor function.

2678366 (1092352)
• When a construct such as '01'/'02'/'03' exists in source code without any spaces between the literal

constants and the divide symbols, a mismatched quote is no longer erroneously created by the macro
preprocessor, causing %IF to be incorrectly evaluated.

2677263 (1092243)
• PL/I source code with mismatched single or double quotes and more than 16384 bytes before either

another quote terminator or and end of the file no longer results in a heap corruption and termination of
the macro preprocessor without first generating a preprocessed source deck.

2676511 (1092209)
• Using the macro preprocessor -full_list option on a user program that had a syntactically incorrect

%INCLUDE statement no longer causes the macro preprocessor to trap.

2676508 (1092171)
• PL/I programs using the macro preprocessor built-in functions COMMENT() or QUOTE() no longer

revieve warning messages, and the generated code is no longer different to what is generated on the
mainframe.

2675054 (1092006)
• The macro preprocessor no longer erroneously generates an error message when a comment

containing a percent sign (%) is immediately preceded by a multiplication symbol (*).

2673315 (1091839)
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Open PL/I RTS

Back to the list

• When using buffered file I/O that is flushed to disk as a result of an implicit or explicit CLOSE, the "out of
space" error now correctly raises a PL/I "ERROR" condition.

2680494 (1092560)
• Previously, when transitioning from one IMS trancode to the next, the PL/I run-time system was not

initializing or deinitializing correctly.

2675644 (1092070)
• The ANY and ALL built-in functions no longer produce the wrong number of bits.

2673494 (1091882)
• If the EXTSM (sort engine) initializes but is not used, the sort engine now properly performs a clean-up

and de-initialization before any subsequent re-initialization. This allows the sort engine to be in a proper
state for subsequent calls to PLISRTD.

2672840 (1091787)
• The PL/I PLIDUMP facility has been enhanced to display information about the files which have been

accessed during execution if the "F" PLIDUMP option is specified.

2671365 (1092268)
• Invoking the DELAY() statement with a negative value no longer causes the application to sleep for a

longer than anticipated period given the specified value. The sleep period is now immediate.

Open PL/I SQL Preprocessor

Back to the list

• The OpenESQL pre-compiler sometimes incorrectly processed host variables in the FETCH INTO
statement for PL/I compiles, resulting in ES0109 errors.

2683997 (1092921)
• The DB2 pre-compiler incorrectly generated MPLIE0095S errors if a fixed CHAR host variable was

defined as greater than 254 characters.

2681503 (1092687)
• The DB2 pre-compiler failed to generate required code if the PL/I program had a one character name,

which resulted in severe MFPLI00082S errors.

2681500 (1092774)
• A SQL preprocessor issue with using the [NODIALECT] option no longer occurs.

2677880 (1092301)
• The generated source code now contains %rdebug in the correct place.

2674774 (1091987)
• The SQL precompiler no longer incorrectly process PL/I programs with a particular language construct.

2673850 (1091889)
• Previously, you received an incorrect error message if an INIT clause in your code contained an

undeclared variable.

2673452 (1091871)
• The SQL preprocessor could generate code that resulted in Compiler errors if an END <program name>

statement was split over two lines.

2672588 (1091776)

RJSE - JCL

Back to the list
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• MFA server can now import SYSOUT data sets with a maximum LRECL of 32K which is the system
limit.

2658439 (1090815)

Run-Time System

Back to the list

• When a container end event is received, all external files that are open in the container now close
correctly.

2513669 (1079282)

Setup Issues (UNIX)

Back to the list

• A problem with the installer where it was not performing a check for whether libstdc++ is installed has
been fixed. You no longer receive an error "CASCD0144S SEP 00002 for ES ESDEMO exited with
value 00127" when trying to start 32-bit enterprise servers.

2672995 (1092055)

SQL: COBSQL

Back to the list

• COBSQL Pro*COBOL error messages displayed only up to 80 characters.

2681983 (1092788)
• Previously, commented-out END-EXEC statements were causing a Compiler error. COBSQL now

ignores such statements.

2680341 (1092533)
• The COBSQL precompiler was updated so it does not attempt conversion of source lines containing the

continuation character.

2663986 (1090930)

SQL: DB2 ECM

Back to the list

• When a CREATE TABLE statement contained a PARTITION parameter, the HCO DDL processor
sometimes generated invalid DDL.

2682214 (1092725)
• A new option (SAVEDDL) is available in the HCO DDL processor. With this option set, any DDL

converted from the input DDL file is saved and not executed. The DDL processor now supports
specifying the IN <tablespace> and COMPRESS <option> parameters but not modifying them.

2673448 (1091907)
• Previously, the HCO IMPORT tool could go into a loop if the LOB column was in the import data set.

2673443 (1091887)
• When compiling on a 64-bit systems, the DB2 pre-compiler incorrectly generated an error "DB0121

Package name is too long."

2673259 (1091920)
• The HCO DDL processor now accepts column names greater than 18 characters. Previously, in this

situation, you received SQLCODE error -205 when the DDL was processed.

2673085 (1091829)
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• The HCO IMPORT tool now supports a new parameter (SAVEDEL) which enables converting DSN
import files to delimited format. When used with this paramter, the HCO IMPORT tool only converts the
file and does not perform an actual import.

2672865 (1091891)
• The HCO Import Data tool was not checking for invalid lengths passed for VARCHAR column data; the

tool now checks this and when an invalid length is passed, issues an error message identifying the
affected column.

2661781 (1091056)

SQL: HCO for SQL Server

Back to the list

• HCOSS now handles statements of type "SET hostVariable = CURRENT SQLID" correctly.

2693537 (1093690)
• The HCOSS Assess Application Migration tool flagged CALL statements as errors without checking

parameter directions. These CALL statements are now flagged as 'in doubt' to initiate an assessment of
parameter directions.

2685247 (1093156)
• The OpenESQL preprocessor and runtime now support AMODE(31) address pointers and swapping

COMP fields in SQLDA for user-defined mainframe style SQLDAs.

2684229 (1092978)
• COBOL stored procedures could not perform database updates when called from a SQL Server trigger.

2680257 (1092809)
• OpenESQL and HCOSS now correctly compile statements that contain CASE expressions.

2679336 (1092605)
• OpenESQL now supports a generic syntax for setting and rolling back to transaction save points that

work with Oracle, DB2, and SQL Server.

2676145 (1092138)
• Although mainframe DB2 supports FETCH INSENSITIVE from SENSITIVE STATIC cursors, which has

a SQL Server equivalent KEYSET cursor, SQL Server does not support FETCH INSENSITIVE from
KEYSET cursor. This is a permanent limitation.

2676140 (1092137)
• OpenESQL did not support BLOB, CLOB, and DBCLOB host variables larger than 64K.

2649752 (1089622)

SQL: OpenESQL

Back to the list

• OpenESQL did not support using the DB2 VALUES INTO statement with DB2 LUW.

2694069 (1093906)
• The OpenESQL preprocessor incorrectly rejected host variable character definitions that contained

x'091' characters.

2692065 (1093465)
• You can now specify SQL(NOCHECKSINGLETON) in applications that require compatibility with older

products to check for unfetched rows after a singleton SELECT. In such cases, the returned SQLCODE
value is zero rather than an error or a warning.

2691736 (1093420)
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• The SQL(TSTAMPSEP)compiler directive could not be explicitly set to a space character, for example
SQL(TSTAMPSEP= ). This is now the default setting unless overridden by specifying
SQL(DIALECT=MAINFRAME).

2691212 (1093364)
• In the IDE, the TSTAMPSEP directive was not listed as an OpenESQL compiler directive option.

2685702 (1093116)
• When SQL(NODETECTDATE) is set after SQL(DIALECT=MAINFRAME), HCOSS does not attempt to

convert date, time or timestamp literals in static or dynamic SQL statements.

2685422 (1093615)
• DB2 LUW applications could not use DECLARE GLOBAL TEMPORARY TABLE statements that were

not syntactically valid for DB2 z/OS.

2685219 (1093346)
• The sqlda.cpy copybook could not be compiled using the ENTCOBOL mainframe dialect.

2682522 (1092825)
• A new XA switch module is now available that supports XA recovery.

2680297 (1092528)
• Previously, you would receive error COBCH002 when SQL(NOPRE) was specified because the ODBC

precompiler would try to generate code using a variable which was not defined.

2679267 (1092438)
• The OpenESQL pre-compiler generated code that swap COMP host variables incorrectly if the SQL

statement got an SQL runtime error.

2677606 (1093013)
• The OpenESQL precompiler sometimes incorrectly generated swap code for COMP host variables if

they were used for both input and output in same SQL statement which resulted in SQLCODE of +100
being returned.

2675122 (1092454)
• A problem with SQL(CHECK) no longer occurrs when using binary host variables.

2673281 (1091832)
• A problem with nested select queries in ESQL 'select into' statements has been fixed.

2672519 (1091768)
• Previously, an incorrect code was generated for an INSERT statement that used an indicator variable

array when DBMAN=ADO was set.

2671938 (1091715)
• The support for EXEC SQL GET DIAGNOSTICS has been extended to include DB2_ROW_NUMBER,

ROW_NUMBER and COLUMN_NUMBER as diagnostic items that can be retrieved by an application.

2670955 (1091611)
• The OpenESQL preprocessor could sometimes improperly decode DBCS host variable characters

which resulted in receiving an "ES0109 Invalid data name" message.

2670725 (1091594)
• The OpenESQL pre-compiler incorrectly changed the underscore character (_) to a dash character (-) in

an EXEC SQL WHENEVER statement.

2670723 (1091593)
• Dynamic SQL statements were not releasing JDBC cursors.

2670548 (1091585)
• OpenESQL for JVM COBOL prevented type byte[] host variables from being used.

2667023 (1091240)
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• The SQL Directives information available within the Visual Studio and Eclipse IDEs contained an error
regarding the available options for the XDB(DATE) and XDB(TIME) directives.

2666213 (1091185)
• Some issues relating to the use of PIC G /PIC N DISPLAY-1 and some DBCS host variables have been

resolved.
• When using Data Direct ODBC drivers, PIC N NATIONAL host variables always uses UTF-16 instead of

UTF-8 which previously happened on some platforms.
• Some problems with using Data Direct's ODBC driver for Microsoft SQL Server have been fixed.

UNIX Cob

Back to the list

• Cob now checks for duplicate symbols defined in objects that are passed to cob for linking.

2651626 (1089779)
• Previously, ccbl was leaving behind a file named cobxi* in the $TMPDIR or /var/tmp directories.

Web Service Client

Back to the list

• Support for nested COUNT IN clauses has been added to the generated Web Service Console Client.
Empty and unused array fields will no longer be returned in the client output.

2278428 (1066547)

XDB Server

Back to the list

• MFDB2UNL.CBL now allows the use of semi-colons within SQL statements.

2661513 (1090755)

XDB: Problems not classed above

Back to the list

• Previously, TESTCOVER configuration could cause spurious errors in XDB utilities.

2677742 (1092299)

XML Syntax Support Preprocessor

Back to the list

• PREXML now handles conditional compilation correctly.

2665552 (1091113)
• An XML file being opened for input is now closed correctly.

2664760 (1091006)

XML Syntax Support Runtime

Back to the list

• The XML run-time system now handles non-US EBCDIC characters correctly.

2665518 (1091086)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
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4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.

Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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